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Contents of the Package
The package of the A-300PRO/500PRO/800PRO (which we’ll subsequently refer to as the A-PRO) contains the following items. When you open the package, first make sure that all items are
included. If any are missing, contact the dealer where you purchased the A-PRO.

MIDI keyboard controller A-PRO

USB cable
Use this cable to connect the A-PRO to the USB connector of your computer. For details
on connections, refer to “Installing the Driver” (p. 12).

fig

* Please use only the included USB cable. If you require a replacement for the supplied
USB cable (for example due to damage or loss), please contact the nearest Roland
Service Center, or an authorized Roland distributor, as listed on the separate sheet
titled “Information.”

Owner’s manual
This is the document you’re reading. Keep it at hand for reference when needed.
* The photo show the A-500PRO.

Cakewalk Production Plus Pack installation guide
CD-ROM, DVD-ROM (one each)

This explains the installation and user registration process for the software included on
the Cakewalk Production Plus Pack DVD-ROM. Unless you complete the user
registration and obtain a registration code as directed in this guide, you won’t be able
to use the software for more than thirty days after installation.

A-PRO CD-ROM
This contains the A-PRO drivers.
Cakewalk Production Plus Pack DVD-ROM
Cakewalk Production Plus Pack, packed with a lavish array of high-quality music
production tools, is included.
* Avoid touching or scratching the shiny underside (encoded surface) of the disc.
Damaged or dirty discs may not be read properly. Keep your discs clean using a
commercially available CD cleaner.
202

Do not attempt to play back a CD-ROM or DVD-ROM in a conventional
audio CD player. The resulting sound may be of a level that could cause
permanent hearing loss. Damage to speakers or other system components
may result.

2

Copyright © 2010 ROLAND CORPORATION
All rights reserved. No part of this publication may be reproduced in any form
without the written permission of ROLAND CORPORATION.
201a

Before using this unit, carefully read the sections entitled: “USING THE UNIT
SAFELY” and “IMPORTANT NOTES” (p. 3; p. 5). These sections provide important
information concerning the proper operation of the unit. Additionally, in order to
feel assured that you have gained a good grasp of every feature provided by your
new unit, Owner’s manual should be read in its entirety. The manual should be
saved and kept on hand as a convenient reference.
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USING THE UNIT SAFELY
008e

About

WARNING and

CAUTION Notices

About the Symbols
The symbol alerts the user to important instructions or
warnings.The specific meaning of the symbol is
determined by the design contained within the triangle. In
the case of the symbol at left, it is used for general
cautions, warnings, or alerts to danger.

Used for instructions intended to alert the
user to the risk of death or severe injury
should the unit be used improperly.
Used for instructions intended to alert the
user to the risk of injury or material
damage should the unit be used
improperly.

The symbol alerts the user to items that must never be
carried out (are forbidden). The specific thing that must
not be done is indicated by the design contained within
the circle. In the case of the symbol at left, it means that
the unit must never be disassembled.

* Material damage refers to damage or
other adverse effects caused with
respect to the home and all its
furnishings, as well to domestic animals
or pets.

The symbol alerts the user to things that must be
carried out. The specific thing that must be done is
indicated by the design contained within the circle. In the
case of the symbol at left, it means that the power-cord
plug must be unplugged from the outlet.

ALWAYS OBSERVE THE FOLLOWING

• Use only the attached power-supply cord. Also,
the supplied power cord must not be used with
any other device.

..............................................................................................................
009

• Do not excessively twist or bend the power cord,
nor place heavy objects on it. Doing so can
damage the cord, producing severed elements
and short circuits. Damaged cords are fire and
shock hazards!

..............................................................................................................
011

• Do not allow any objects (e.g., flammable material,
coins, pins); or liquids of any kind (water, soft
drinks, etc.) to penetrate the unit.

..............................................................................................................
012b

002c

004

• Do not open (or modify in any way) the unit or its
AC adaptor.

• Never install the unit in any of the following locations.
• Subject to temperature extremes (e.g., direct
sunlight in an enclosed vehicle, near a heating
duct, on top of heat-generating equipment); or are
• Damp (e.g., baths, washrooms, on wet floors); or are
• Exposed to steam or smoke; or are
• Subject to salt exposure; or are
• Humid; or are
• Exposed to rain; or are
• Dusty or sandy; or are
• Subject to high levels of vibration and shakiness.

..............................................................................................................
003

• Do not attempt to repair the unit, or replace parts
within it (except when this manual provides specific
instructions directing you to do so). Refer all
servicing to your retailer, the nearest Roland Service
Center, or an authorized Roland distributor, as
listed on the separate sheet titled “Information.”

..............................................................................................................
007

• Make sure you always have the unit placed so it is
level and sure to remain stable. Never place it on
stands that could wobble, or on inclined surfaces.

..............................................................................................................

..............................................................................................................
008b

• Use only the specified AC adaptor (sold separately),
and make sure the line voltage at the installation
matches the input voltage specified on the AC
adaptor’s body. Other AC adaptors may use a
different polarity, or be designed for a different voltage, so their
use could result in damage, malfunction, or electric shock.

..............................................................................................................

• Immediately turn the power off, remove the AC
adaptor from the outlet, and request servicing by
your retailer, the nearest Roland Service Center, or
an authorized Roland distributor, as listed on the
separate sheet titled “Information” when:
• The AC adaptor, the power-supply cord, or the
plug has been damaged; or
• If smoke or unusual odor occurs
• Objects have fallen into, or liquid has been
spilled onto the unit; or
• The unit has been exposed to rain (or otherwise
has become wet); or
• The unit does not appear to operate normally or
exhibits a marked change in performance.

..............................................................................................................
013

• In households with small children, an adult should
provide supervision until the child is capable of
following all the rules essential for the safe
operation of the unit.

..............................................................................................................
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USING THE UNIT SAFELY

012d

101b

109b

• Immediately turn the power off, and request
servicing by your retailer, the nearest Roland
Service Center, or an authorized Roland
distributor, as listed on the separate sheet titled
“Information” when:
• If smoke or unusual odor occurs
• Objects have fallen into, or liquid has been
spilled onto the unit; or
• The unit has been exposed to rain (or otherwise
has become wet); or
• The unit does not appear to operate normally or
exhibits a marked change in performance.

• The unit and the AC adaptor should be located so
their location or position does not interfere with
their proper ventilation.

• Before cleaning the unit, turn off the power and
unplug the AC adaptor from the outlet.

..............................................................................................................
014

• Protect the unit from strong impact.
(Do not drop it!)

..............................................................................................................
015

• Do not force the unit’s power-supply cord to share
an outlet with an unreasonable number of other
devices. Be especially careful when using
extension cords—the total power used by all
devices you have connected to the extension
cord’s outlet must never exceed the power rating
(watts/amperes) for the extension cord. Excessive
loads can cause the insulation on the cord to heat
up and eventually melt through.

..............................................................................................................
016

• Before using the unit in a foreign country, consult
with your retailer, the nearest Roland Service
Center, or an authorized Roland distributor, as
listed on the separate sheet titled “Information.”

..............................................................................................................
023

• Do not attempt to play back a CD-ROM or DVDROM in a conventional audio CD player. Damage
to speakers or other system components may
result.

..............................................................................................................

..............................................................................................................

..............................................................................................................

102c

110b

• Always grasp only the plug on the AC adaptor cord
when plugging into, or unplugging from, an outlet
or this unit.

..............................................................................................................

..............................................................................................................

103b

• At regular intervals, you should unplug the AC
adaptor and clean it by using a dry cloth to wipe all
dust and other accumulations away from its
prongs. Also, disconnect the power plug from the
power outlet whenever the unit is to remain
unused for an extended period of time. Any
accumulation of dust between the power plug and
the power outlet can result in poor insulation and
lead to fire.

..............................................................................................................
104

• Try to prevent cords and cables from becoming
entangled. Also, all cords and cables should be
placed so they are out of the reach of children.

..............................................................................................................
106

• Never climb on top of, nor place heavy objects on
the unit.

204

* Microsoft, Windows, and Windows Vista are registered
trademarks of Microsoft Corporation.
206e

* The screen shots in this document are used in compliance
with the guidelines of the Microsoft Corporation.
206j

* Windows® is known officially as: “Microsoft® Windows®
operating system.”
207+209

* Apple, Macintosh, and Mac OS are registered trademarks of
Apple Inc.
* Cakewalk is a registered trademark of Cakewalk, Inc.

..............................................................................................................

* SONAR and Cakewalk logo are trademarks of Cakewalk, Inc.

107c

220

• Never handle the AC adaptor or its plugs with wet
hands when plugging into, or unplugging from,
an outlet or this unit.

* All product names mentioned in this document are trademarks
or registered trademarks of their respective owners.

..............................................................................................................
108b

• Before moving the unit, disconnect the AC
adaptor and all cords coming from external
devices.

..............................................................................................................
108c

• Disconnect all cords coming from external
devices before moving the unit.

..............................................................................................................

4

• Whenever you suspect the possibility of lightning
in your area, disconnect the AC adaptor from the
outlet.

* MMP (Moore Microprocessor Portfolio) refers to a patent
portfolio concerned with microprocessor architecture, which
was developed by Technology Properties Limited (TPL). Roland
has licensed this technology from the TPL Group.
* Roland and GS are either registered trademarks or trademarks
of Roland Corporation in the United States and/or other
countries.

A-300_500_800C_e.book

5 ページ

２０１０年２月２２日

月曜日

午後９時１３分

IMPORTANT NOTES
Power Supply
301

• Do not connect this unit to same electrical outlet that is being
used by an electrical appliance that is controlled by an
inverter (such as a refrigerator, washing machine, microwave
oven, or air conditioner), or that contains a motor. Depending
on the way in which the electrical appliance is used, power
supply noise may cause this unit to malfunction or may
produce audible noise. If it is not practical to use a separate
electrical outlet, connect a power supply noise filter between
this unit and the electrical outlet.
302

• The AC adaptor will begin to generate heat after long hours of
consecutive use. This is normal, and is not a cause for concern.

358

• Do not allow objects to remain on top of the keyboard. This
can be the cause of malfunction, such as keys ceasing to
produce sound.
360

• Depending on the material and temperature of the surface on
which you place the unit, its rubber feet may discolor or mar
the surface.
You can place a piece of felt or cloth under the rubber feet to
prevent this from happening. If you do so, please make sure
that the unit will not slip or move accidentally.

Additional Precautions
551

• Please be aware that the contents of memory can be
irretrievably lost as a result of a malfunction, or the improper
operation of the unit. To protect yourself against the risk of
losing important data, we recommend that you periodically
save a backup copy of important data you have stored in the
unit’s memory in your computer.
552

Maintenance

• Unfortunately, it may be impossible to restore the contents of
data that was stored in your computer once it has been lost.
Roland Corporation assumes no liability concerning such loss
of data.

401a

553

• Before connecting this unit to other devices, turn off the
power to all units. This will help prevent malfunctions and/or
damage to speakers or other devices.

• For everyday cleaning wipe the unit with a soft, dry cloth or
one that has been slightly dampened with water. To remove
stubborn dirt, use a cloth impregnated with a mild, nonabrasive detergent. Afterwards, be sure to wipe the unit
thoroughly with a soft, dry cloth.

• Use a reasonable amount of care when using the unit’s
buttons, sliders, or other controls; and when using its jacks
and connectors. Rough handling can lead to malfunctions.

Placement

402

• When connecting / disconnecting all cables, grasp the
connector itself—never pull on the cable. This way you will
avoid causing shorts, or damage to the cable’s internal
elements.

307

352a

• This device may interfere with radio and television reception.
Do not use this device in the vicinity of such receivers.
352b

• Noise may be produced if wireless communications devices,
such as cell phones, are operated in the vicinity of this unit.
Such noise could occur when receiving or initiating a call, or
while conversing. Should you experience such problems, you
should relocate such wireless devices so they are at a greater
distance from this unit, or switch them off.
354a

• Do not expose the unit to direct sunlight, place it near devices
that radiate heat, leave it inside an enclosed vehicle, or
otherwise subject it to temperature extremes. Excessive heat
can deform or discolor the unit.

• Never use benzine, thinners, alcohol or solvents of any kind, to
avoid the possibility of discoloration and/or deformation.

Repairs and Data
452

• Please be aware that all data contained in the unit’s memory
may be lost when the unit is sent for repairs. Important data
should always be backed up in your computer, or written
down on paper (when possible). During repairs, due care is
taken to avoid the loss of data. However, in certain cases (such
as when circuitry related to memory itself is out of order), we
regret that it may not be possible to restore the data, and
Roland assumes no liability concerning such loss of data.

554

• Never strike or apply strong pressure to the display.
556

558b

• To avoid disturbing your neighbors, try to keep the unit’s
volume at reasonable levels (especially when it is late at
night).
559a

• When you need to transport the unit, package it in the box
(including padding) that it came in, if possible. Otherwise, you
will need to use equivalent packaging materials.
561

• Use only the specified expression pedal (EV-5 or EV-7; sold
separately). By connecting any other expression pedals, you
risk causing malfunction and/or damage to the unit.

355b

• When moved from one location to another where the
temperature and/or humidity is very different, water droplets
(condensation) may form inside the unit. Damage or
malfunction may result if you attempt to use the unit in this
condition. Therefore, before using the unit, you must allow it
to stand for several hours, until the condensation has
completely evaporated.

CD-ROM and DVD-ROM handling
801

• Do not touch the data surface (the unprinted surface) of the
disc, or allow it to be scratched. Doing so may make the data
unreadable. If the disc gets dirty, clean it using a commercially
available disc cleaner.
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Names of Things and What They Do
Panel

2

1

1 Display
This shows a variety of information, such as the current state.
Indication

Summary

Alphanumeric
characters

When you operate a controller, the value of the parameter assigned to that
controller is shown for a certain duration. Information such as the MIDI channel and program change is also shown.

PRM MUTE

When the cursor is located here, moving a controller will not transmit MIDI
messages (p. 47).

CTRL MAP

When the cursor is located here, you can turn the [VALUE] knob 2 to switch
between control maps stored in the A-PRO (p. 21).

PGM CHANGE

When the cursor is located here, you can turn the [VALUE] knob 2 to transmit a program change on the current channel (p. 43).

MIDI CH

When the cursor is located here, you can turn the [VALUE] knob 2 to
change the MIDI channel on which the keyboard or bender lever will transmit (p. 42).

USER ASSIGN

When the cursor is located here, you can turn the [VALUE] knob 2 to
change the value of a user-assigned parameter (p. 68).

4

3

5

6

7

f
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.
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e
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8

9

2 [VALUE] knob, [ENTER] button
You can turn the [VALUE] knob to change the MIDI channel, switch program changes
or control maps, or change the value of a user-specified parameter.
In EDIT mode, use the [VALUE] knob to select an item or edit its value.
When this knob is pressed, it functions as the [ENTER] button.

3 [ACT] button
10

8

Press the [ACT] button if you’re using SONAR or software compatible with ACT (Active
Controller Technology) (p. 21).
You can use controllers [B1]–[B4], [R1]–[R9], [L1]–[L9], [S1]–[S9], and [A1]–[A8] to
operate SONAR or your ACT-compatible software.
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Names of Things and What They Do

4 [

] button, [

] button

You can use the [
][
] buttons to move the cursor that is shown at CTRL MAP,
PGM CHANGE, MIDI CH, or USER ASSIGN in the display.

10 Bender lever
Use this to change the pitch or apply vibrato.
You can also assign a desired MIDI message to this lever as a controller.
➝ “Assigning MIDI Messages” (p. 29)

5 Controllers [B1]–[B4] (button)
You can assign any desired MIDI messages to these buttons.
➝ “Assigning MIDI Messages” (p. 29)

6 [SPLIT] button, [DUAL] button, [LOWER] button, [UPPER] button
[SPLIT] button
Use this button to split the keyboard into right (UPPER) and left (LOWER) areas so that
you can play a different sound in each area.
[DUAL] button
Use this button to play two sounds layered.
[LOWER] button
Use this button to play the LOWER part.
[UPPER] button
Use this button to play the UPPER part.

7 [SHIFT] button
When you’re in PLAY mode (p. 41), you can hold down the [SHIFT] button and use
controllers [B1]–[B4], the [DUAL]/[LOWER]/[UPPER] buttons, the [TRANSPOSE] button,
and the OCTAVE [–] [+] buttons as a numeric keypad. Hold down the [SHIFT] button and
press the [SPLIT] button for backspace.

8 [TRANSPOSE] button
This button lets you shift the pitch of the keyboard up or down in steps of a semitone.
➝ “TRANSPOSE” (p. 62)

9 OCTAVE [–] [+] buttons
These buttons let you shift the pitch of the keyboard up or down in steps of one octave.

9
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Names of Things and What They Do

fig.Panel-Top.eps

11

12

13

11 Controllers [R1]–[R9] (knobs)
You can assign the desired MIDI messages to these knobs.
➝ “Assigning MIDI Messages” (p. 29)

12 Controllers [L1]–[L8] (button)
You can assign the desired MIDI messages to these buttons.
➝ “Assigning MIDI Messages” (p. 29)

13 [HOLD] button
This button turns Hold on/off (a function that sustains the note even after you release
the [A1]–[A8] pad).
Alternatively, you can assign a desired MIDI message to this button or use it to turn
V-LINK on/off instead of using it as Hold.
➝ “L9 FUNCTION” (p. 69)

10

14

15

V-LINK
V-LINK (
) is a function that allows music and images to be performed
together. By using MIDI to connect two or more V-LINK compatible devices, you can
easily enjoy a wide range of visual effects that are linked to the expressive elements of
a music performance.

14 Controllers [S1]–[S9] (sliders)
You can assign the desired MIDI messages to these sliders.
➝ “Assigning MIDI Messages” (p. 29)

15 Controllers [A1]–[A8] (pads)
You can assign the desired MIDI messages to these pads.
➝ “Assigning MIDI Messages” (p. 29)
These pads can transmit velocity values that correspond to the force with which you
pressed the pad, or aftertouch values.
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Side Panel
18 USB connector

fig.Panel-Side.eps

Use this to connect the A-PRO to your computer via a USB cable.

19 [MIDI MERGE] switch
This switch turns the Merge function on/off for messages from MIDI IN.
➝ “MIDI MERGE DESTINATION” (p. 67)

20 MIDI IN/OUT connectors
You can connect these connectors to the MIDI connectors of other MIDI equipment to
transmit and receive MIDI messages.
➝ “MIDI-related Settings” (p. 66)

21 HOLD (P1) jack, EXPRESSION (P2) jack
Connect the appropriate type of pedal to each of these connectors.

16

17

18

19

20

21

22

16 DC IN jack
You can connect a separately sold AC adaptor here. If you want to purchase an AC
adaptor, contact the retailer from whom you purchased the product, or the nearest
Roland Service Center.

17 [Power] switch
DC

Power on using the AC adaptor

OFF

Power off

USB

Power on with the USB cable connected
USB (i.e., bus power) can be used when the A-PRO is connected to your computer
via a USB cable. The power is supplied from the computer via the USB cable.
* The A-PRO might not operate on bus power with some computers. In this case,
please use the separately sold AC adaptor.

HOLD

Connect a pedal switch (DP-2, DP-10; sold separately) here and use it as a
Hold pedal.

EXPRESSION

Connect an expression pedal (EV-5, EV-7; sold separately) here and use it to
control the sound or volume in real time.

You can also assign any desired MIDI message to these controllers.
➝ “Assigning MIDI Messages” (p. 29)
* Use only the specified expression pedal (EV-5 or EV-7; sold separately). By
connecting any other expression pedals, you risk causing malfunction and/or
damage to the unit.

22 Security slot (

)

http://www.kensington.com/

11

A-300_500_800C_e.book 12 ページ ２０１０年２月２２日

月曜日

午後９時１３分

Installing the Driver
A driver is software that transfers data between the A-PRO and the application software
on your computer when the A-PRO is connected to your computer.

Windows 7/Windows Vista Users
Steps to be performed on the A-PRO keyboard itself are marked by a

The procedure for installation and checking will depend on your system. Perform the
following two steps to install and check the driver.

Operation of the A-PRO

1.
2.

symbol. Don’t connect the A-PRO to your computer until you

are told to do so.

fig.H_install.eps

Install driver

Check

* The example screen shots included here are taken from Windows 7.

Windows 7 /
Windows Vista

Windows XP

Mac OS X

P. 12

P. 15

P. 17

P. 19

P. 19

P. 20

1

With the A-PRO disconnected, start up Windows.
Disconnect all USB cables from your computer, with the exception of those for a
USB keyboard and USB mouse (if used).

2

Close all currently running software.

3

Insert the included A-PRO CD-ROM into your CD-ROM drive.
When the auto-play dialog box appears, click [Open folder to view files].

4

In the appropriate folder within the CD-ROM, double-click the
[Setup] icon to start up the installer.
OS

Installer

Windows 7

Open the folders [Driver] and then [Win7]

Windows Vista

Open the folders [Driver] and then [Vista]

Windows 7 64-bit edition

Open the folders [x64Driver] and then [Win7]

Windows Vista 64-bit edition

Open the folders [x64Driver] and then [Vista]

If you get a message saying “The operating system you are using is not supported” or
“The version of this file is not compatible with the version of Windows you’re running,”
or if you don’t know the version of your operating system, check your operating system
as described below.
If “System type” indicates “64-bit Operating System,” you have the 64-bit version.

12
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Installing the Driver

Windows 7 users
Open “Control Panel,” click “System and Security,” and then click [System].
If the Control Panel shows the icon view, click [System].

7

To begin the installation, click [Next] once again. Installation will
begin.

fig.win7securitya-e.eps_36

Windows Vista users
Open “Control Panel,” click [System and Maintenance], and then click [System].
If the Control Panel shows the classic view, double-click the “System” icon.

5

A user account control confirmation screen will appear.
Click [Yes] if you’re using Windows 7, or click [Continue] if you’re
using Windows Vista.

fig.win7uac_e.eps

If a Windows security dialog box appears, click [Install].

8
6

The screen will indicate “A-PRO Driver will be installed on your
computer.” Click [Next].
If any other message appears, proceed as directed by the message.

9

Operation of the A-PRO

Turn the A-PRO’s [POWER] switch OFF.

When the screen indicates “Ready to install the
driver,” use a USB cable to connect the A-PRO to your computer.
Operation of the A-PRO

fig.win7drv3-e.eps_36

If any other message appears, proceed as directed by the message.

10

Operation of the A-PRO

Set the A-PRO’s [POWER] switch to USB.

The driver will be installed automatically.

13
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Installing the Driver

11

When the installation is completed, the “A-PRO Driver Setup” dialog
box will indicate “Installation has been completed.”
Click [Close] to close the “A-PRO Driver Setup” dialog box.
If the “System Settings Change” dialog box appears, click [Yes]. Windows will
automatically restart.
Now let’s check to make sure that installation was successful.
➝ “Checking with a SONAR Soft Synths (Windows)” (p. 19)

14
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Windows XP Users
Steps to be performed on the A-PRO keyboard itself are marked by a Operation of the A-PRO symbol. Don’t connect the A-PRO to your computer until you are told to do so.

1

With the A-PRO disconnected, start up Windows.

If the “Software Installation” dialog box appears, click [Continue Anyway] to
continue the installation.

Disconnect all USB cables from your computer, with the exception of those for a
USB keyboard and USB mouse (if used).

2

Close all currently running software.

3

Insert the included A-PRO CD-ROM into your CD-ROM drive.

4

On the CD-ROM, open the [Driver] folder and then the [XP] folder,
and double-click the [Setup] icon.
If you get a message saying “The operating system you are using is not supported”
or saying that the application is invalid, check the version of your operating
system.

If you are unable to proceed, click [OK] in the dialog box to terminate the
installation. Then change the setting as described in “Driver signing option
settings (Windows XP)” (p. 80), and perform the installation once again.

7
8

Operation of the A-PRO

Set the A-PRO’s [POWER] switch to OFF.

Operation of the A-PRO When the “Ready to install the driver” message
appears, use a USB cable to connect the A-PRO to your computer.

fig.xpdrv4-e.eps_27

If the “Install Program As Other User” dialog box appears, click [Cancel] to
terminate the installation, log on to Windows using an administrator account, and
perform the installation once again.

5

The screen will indicate “A-PRO Driver will be installed on your
computer.” Click [Next].
If any other message appears, proceed as directed by the message.

6

To begin the installation, click [Next].

fig.xpdrv2-e.eps_27

If any other message appears, proceed as directed by the message.

9

Operation of the A-PRO

Set the A-PRO’s [POWER] switch to USB.

The indication “Found New Hardware” will appear in the lower right corner of your
screen.
* It may take between ten seconds to several minutes for the “Found New Hardware
Wizard” to appear.

15
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10

If you are asked whether you want to connect to Windows Update,
choose [No, not this time] and click [Next].

fig.xpwupd-e.eps

11

12

If the “Hardware Installation” dialog box appears, click [Continue
Anyway] to continue the installation.

fig.xpdrv7-e.eps

If you are unable to proceed, click [OK] in the dialog box to terminate the
installation. Then change the setting as described in “Driver signing option
settings (Windows XP)” (p. 80), and perform the installation once again.

Choose [Install the software automatically (Recommended)], and
click [Next].

fig.xpdrv6-e.eps

13

The screen will indicate “Completing the Found New Hardware
Wizard.” Click [Finish].

14

When installation is complete, the “A-PRO Driver Setup” dialog box
will indicate “Installation has been completed.”
Click [Close] to close the “A-PRO Driver Setup” dialog box.
If the “System Settings Change” dialog box appears, click [Yes] to restart Windows.
Now let’s check to make sure that installation was successful.
This completes driver installation and settings.
➝ “Checking with a SONAR Soft Synths (Windows)” (p. 19)

16

A-300_500_800C_e.book 17 ページ ２０１０年２月２２日

月曜日

午後９時１３分

Installing the Driver

Mac OS X Users
Steps to be performed on the A-PRO keyboard itself are marked by a Operation of the A-PRO symbol. Don’t connect the A-PRO to your computer until you are told to do so.

1

* If the “Authenticate” or “Installer requires that you type your password” dialog box
appears during the installation, enter an administrator password and click [OK].

6

If the screen asks you to select a destination, click your start-up disk
to select it, and then click [Continue].

* What you actually see on the screen may differ depending on your system.

7

When the display asks you to select the type of installation, click
[Install] or [Upgrade].

8

In the next screen, click [Continue Installation].

9

When installation is completed, click [Restart] to restart your
computer.

With the A-PRO disconnected, start up your computer.
Disconnect all USB cables from your computer, with the exception of those for a
USB keyboard and USB mouse.

2

Close all currently running software.

3

Insert the included A-PRO CD-ROM into your CD-ROM drive.

4

Double-click one of the following icons on the CD-ROM to start up
the installer.
OS
Mac OS X 10.6 or later
Mac OS X 10.5 or earlier

5

Installer
[APRO_USBDriver.pkg] (/Driver/10.6)

* It may take some time for your computer to restart.

10
11
12

Operation of the A-PRO

Set the A-PRO’s [POWER] switch to OFF.

Operation of the A-PRO When your computer has restarted, use a USB
cable to connect the A-PRO to your computer.
Operation of the A-PRO

Set the A-PRO’s [POWER] switch to USB.

13

Double-click [Audio MIDI Settings] (/Applications/Utility) to start it
up.

14

Access the dialog box.

[APROUSBDriver.pkg] (/Driver/10.4_10.5)

A message concerned with checking whether installation is possible may appear.
If so, click [Continue].

Mac OS X 10.6 or later
From the [Window] menu, choose [Show MIDI Window] to open “MIDI Studio”

If a message indicating that installation is not possible appears, check the
operating system you’re using, and perform step 4.

Mac OS X 10.5 or earlier
Click the [MIDI Devices] tab.

The screen will indicate “Welcome to the A-PRO Driver Installer.”
Click [Continue].

fig.osx-install-e.eps
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15

Verify that [A-PRO] is shown in the “MIDI Studio” or “Audio MIDI
Settings” dialog box.

New Device

fig.osxaudiomidi1-e.eps

18

Device Name

First

A-PRO MIDI OUT

Second

A-PRO

Third

A-PRO MIDI IN

Fourth

A-PRO 1

Fifth

A-PRO 2

Use the mouse to drag between the ▲ and ▼ symbols (representing
input and output, respectively) of [A-PRO] and each [New Device] so
that they are connected as shown in the illustration below.

fig.osxmidiset-e.eps_32

If the A-PRO is not shown or is grayed-out, the A-PRO has not been recognized
correctly. Try clicking [Rescan MIDI]. You can also try disconnecting the USB cable
connected to the A-PRO, then re-connecting it.

16

Click [Add Device] five times.

fig.osxadddevice-e.eps

Five [New Device] items will appear.

17

Specify the device name for each [New Device].
1. Select the [New Device] you added, and click [Show Info].
2. Enter the name in the [Device Name] field. For each [New Device],
enter the following names.

fig.osxnewdevice-e.eps

18

19

Close the “MIDI Studio” dialog box or “Audio MIDI Setup” dialog
box.
Now let’s check to make sure that installation was successful.
➝ “Checking in GarageBand (Mac OS X)” (p. 20)
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Verifying that Installation was Successful
Proceed as follows to verify that the driver was installed correctly.
We will use SONAR LE as an example for Windows, and GarageBand as an example for Mac OS X.

Checking with a SONAR Soft Synths (Windows)
Here’s an example using a plug-in synth included with SONAR LE. The procedure or
screens may differ if you’re using a different version.
For details on installing and setting up SONAR LE, refer to the “Cakewalk Production
Plus Pack Installation Guide.”

1

Start up SONAR LE.

2

In the [Options] menu, click [MIDI Devices].

6

In the “Template” area, choose [Normal]; then enter a project name
in the “Name” field and click [OK].

fig.sonarnew.eps

The “MIDI Devices” dialog box will appear.

3

In the “MIDI Devices” dialog box, choose the following MIDI devices
in the [Inputs] and [Outputs] fields.
Input device
A-PRO MIDI IN
A-PRO 1
A-PRO 2

Output device
A-PRO
A-PRO MIDI OUT

If you’re unable to select A-PRO as an input/output device, it may be that a
problem has occurred.
Refer to “Problems with Settings” in the Troubleshooting section (p. 76).

4

Click [OK] to close the dialog box.

5

In the [File] menu, click [New].

7

In the [Insert] menu, choose [Soft Synths] and then [PSYN II].

8

In the “Insert Soft Synth Options” dialog box, select the [Synth
Property Page] option in the [Open These Windows] area, and click
[OK].

fig.sonarinsertoption-e.eps_34

The “New Project File” dialog box will appear.

9

Play the A-PRO’s keyboard.
If the MIDI monitor in the taskbar responds and you hear the sound of the synth, the
A-PRO is correctly connected to your computer.

19
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Checking in GarageBand (Mac OS X)
GarageBand is software that is included with Apple’s iLife.
Here, the explanation assumes that you’re using GarageBand ‘09. The steps or screens
may be different if you’re using a different version.

1

In the [Applications] folder, double-click [GarageBand].

2

When GarageBand has started up, click the [File] menu item [New].

3

In the “New Project” screen, assign a name and click [Create].

fig.garageband_e.eps

If you don’t hear sound, check the following points.
• From the [GarageBand] menu, click [Preferences]. If MIDI input is not detected in
the [Audio/MIDI] tab’s “MIDI Status” field, it may be that a problem has occurred.
Please refer to “Problems with setup” in the Troubleshooting section (p. 76).
• In “System Preferences,” choose the [Sound]-[Output] tab. Make sure that your
computer’s main volume is not turned down or muted. Also make sure that internal
audio is selected.
• If you’re using headphones, make sure that they are correctly connected to your
computer’s headphone jack.
• If you have an audio interface that’s connected to your computer, refer to the
owner’s manual of your device to make sure that your audio interface is connected
correctly.
If you don’t hear sound in software other than GarageBand, you’ll need to make MIDI
and audio input/output settings. Make the following settings for MIDI input/output.
Input device
A-PRO MIDI IN
A-PRO 1
A-PRO 2

4

Play the A-PRO’s keyboard.
If you hear the Grand Piano sound that’s assigned to the GarageBand track, the A-PRO
is correctly connected to your computer.

20

Output device
A-PRO
A-PRO MIDI OUT
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Look what You Can Do with the A-PRO
Play

Use Control Maps

When playing the A-PRO’s keyboard, you can select sounds in your sound module from
the A-PRO. You can also play two sounds together (DUAL) or separately (SPLIT).

About Control Maps
For details, refer to “Performing (Play Mode)” (p. 41).

Use ACT
If you’re using SONAR, you can use the A-PRO as a controller for SONAR simply by
pressing the A-PRO’s [ACT] button to turn it on.

What is ACT?
ACT (Active Controller Technology) is functionality that lets you control SONAR
from an external device such as the A-PRO. This lets you control the plug-in effect
or plug-in synthesizer that’s active in SONAR without having to make timeconsuming settings.

For details, refer to SONAR’s online help.

A Control Map is an object that describes how MIDI settings are assigned to the
various controllers.
By using Control Maps, you can easily switch to the settings you need for a
particular environment, making it easier for you to use a variety of different
software programs.

The A-PRO provides 19 control maps, and you can control a variety of software simply
by switching between them.
For details, refer to the separate Control Map Guide.

Create Your Own Settings
The A-PRO provides 44 controllers; you can freely assign a MIDI message to each
controller.
For details, refer to “Using A-PRO Editor” (p. 22).
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Using A-PRO Editor
A-PRO Editor is software that lets you create control maps (p. 21) for the A-PRO series
on your computer, and make settings for the keyboard. The graphical screen makes it
easy to edit the values (settings).
fig.editor-mainwindow-e+.eps_39

The A-PRO has a total of 44 controllers: [B1]–[B4], [R1]–[R9], [L1]–[L9], [S1]–[S9], [A1]–
[A8], HOLD (P1), EXPRESSION (P2), BENDER, MODULATION, and AFTERTOUCH. You can
freely assign any MIDI message to be controlled by each controller.
The 44 message assignments for these controllers are collectively called a “control
map.”
Simple assignments of MIDI messages can be made on the A-PRO keyboard itself
without using the editor software. However, A-PRO Editor also allows you to transfer
control map data in and out of the A-PRO keyboard, to edit control map data, and also
to save or load control map settings as SMF format data.
➝ “Assigning a MIDI Message on the A-PRO Keyboard” (p. 48)

Installing A-PRO Editor
Windows Users
1

Insert the included A-PRO CD-ROM into your CD-ROM drive.

2

On the CD-ROM, open the [EDITOR] folder and double-click [SETUP]
to start the installer.

3

The screen “Welcome to the InstallShield Wizard for A-PRO Editor
Setup” will appear. Click [Next].

4

When the “Please Read” screen appears, read the contents, and if
you consent, click [Yes].
You cannot install A-PRO Editor unless you consent to the terms.

5

A dialog box will allow you to specify the installation location.
Simply click [Next].

6

Verify the contents of the “Confirmation of installation” screen, and
then click [Next].
Copying of the files will begin.

7

When copying is completed, click [Finish].
This completes installation of the A-PRO Editor.

Mac OS X Users
1

Insert the included A-PRO CD-ROM into your CD-ROM drive.

2

From the CD-ROM’s [Editor] folder, drag the [A-PRO Editor] folder
and drop it into your Mac’s [Applications] folder to copy it.
This completes installation of the A-PRO Editor.

22
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MIDI Port Assignments
In order to transfer control maps between A-PRO Editor and the A-PRO keyboard, you’ll
need to specify the MIDI ports used by A-PRO Editor.
* If the A-PRO is connected via USB, the ports will be as follows. If you’re using a MIDI
connection, specify the MIDI input port and MIDI output port of the MIDI device to
which the A-PRO is connected, instead of “A-PRO 2” and “A-PRO.”

What is a MIDI port?
A MIDI port is a port used to transfer MIDI messages between your computer
and the A-PRO.

Windows Users
1

Use a USB cable to connect the A-PRO to your computer, then switch
on the A-PRO’s power.

2

Click the Windows [Start], then successively click [All Programs],
[A-PRO Editor], and [A-PRO Editor] to start up A-PRO Editor.

3

In A-PRO Editor, click the [Options] menu item [MIDI Devices].

fig.editor-device-e.eps

4

In the MIDI Devices dialog box,
specify the MIDI devices as shown
in the illustration.

5

Click [OK] to close the dialog box.

Input ports
Input port

Explanation

A-PRO MIDI IN

Receives data that’s input via the A-PRO’s MIDI IN connector.

A-PRO 1

Receives data from A-PRO sliders, knobs, or buttons that are
assigned to “PORT 1.”

A-PRO 2

Receives data from A-PRO sliders, knobs, or buttons that are
assigned to “PORT 2.”
When receiving bulk data from the A-PRO, choose [A-PRO 2]
as the input port.

The output destination of the MIDI messages transmitted when you operate
the A-PRO’s sliders, knobs, and buttons can be specified separately for each
controller. For details, refer to “Two MIDI Ports” (p. 71).

Output ports
Output port

Mac OS X Users
1

Use a USB cable to connect the A-PRO to your computer, then switch
on the A-PRO’s power.

2

Double-click [A-PRO Editor] (/Applications/A-PRO Editor/) to start up
A-PRO Editor.

3
4

In A-PRO Editor, click the [Options] menu command [MIDI Devices].
In the MIDI Devices dialog box, specify the MIDI devices as follows.
Input port

Explanation

A-PRO MIDI OUT

Transmits MIDI messages to MIDI devices connected to the
A-PRO’s MIDI OUT connector.

A-PRO

Transmits MIDI messages to the A-PRO.
When transmitting bulk data from the A-PRO, choose [A-PRO]
as the output port.

Output port

5

A-PRO 2
A-PRO

Click [OK] to close the dialog box.

In order to transmit a control map created using A-PRO Editor to the A-PRO,
you must choose [A-PRO] as the output port.
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Items in the Windows
Main Window

Message Assignment Window

fig.editor-mainwindow-e.eps

fig.editor04-num-e.eps, fig.editor05-num-e.eps

1

2

3

4

1
7

2
3
4

6

8

5

* The items in the window will differ depending on the controller and on the type of
message being assigned.

1 Title
You can assign a name to the control map you’re editing. Only single-byte
alphanumeric characters can be entered for the control map name. The name you
enter here is shown as the title of the HTML file that’s exported by the [File] menu
command [Export Assign List].

1 Controller name
This shows the name of the controller you’re editing.

2 Assign Message selection list
Here you can select the type of MIDI message to be assigned to the controller.

2 Controllers
Explanation

NO ASSIGN

No MIDI message will be assigned

change to a

Channel Message

Channel messages (CC, note, etc.)

System Realtime/F6

System realtime message or F6 (Tune Request)

System Ex.

System exclusive message of up to 24 bytes

Free Message

Any MIDI message of up to 24 bytes (multiple messages are allowed)

Tempo

Tempo control

. Now you can click the controller to open the Assign Message window.

3 [Control Map] dropdown list
Here’s where you select the number of the control map that you want to edit.
For details, refer to “Receiving a Control Map from the A-PRO” (p. 31), and
“Transmitting a Control Map to the A-PRO” (p. 31).

4 [Transmit], [Receive]
Click [Transmit] to save a control map to the A-PRO, overwriting existing content. Click
[Receive] to load a control map from the A-PRO.
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Menu

Here you can click to select the controller to which you want to assign a MIDI message.
When you move the mouse over a controller (a clickable area), the mouse cursor will
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3 Message assignment area

7 Name

Here you can specify the value of various parameters for the MIDI message you
selected in the Assign Message selection list 2 .
For details on the parameters of each MIDI message, refer to “Message Parameters” (p.
33)

4 Output Port

8 Virtual Center Click

This specifies the USB port from which the MIDI messages will be transmitted to a USBconnected computer.
Port

If the controller you’re editing is [R1]–[R9] or [S1]–[S9], you can make virtual center click
settings (p. 55).
This broadens the range in which the center value is transmitted.

Explanation

Port 1

MIDI messages will be transmitted to “A-PRO 1.”

Port 2

MIDI messages will be transmitted to “A-PRO 2.”

Port 1+2

You can enter a name to describe the function you’ve assigned to the controller; this
name is shown in the A-PRO’s display. Up to sixteen single-byte alphanumeric
characters can be entered. The name you enter here is shown in the “PARAMETER” field
of the HTML file exported by the [File] menu command [Export Assign List].

MIDI messages will be transmitted to both “A-PRO 1” and “A-PRO 2.”

Mode

Explanation

OFF

No insensitive range in the center

ON

Insensitive range in the center

5 Button Mode
If the controller is a button, this specifies the button mode.
Mode

Explanation

Unlatch

Turns on when you press the button; turns off when you release it.

Latch

Alternately turns on/off each time you press the button.

Increase

Each time you press the button, the value will be incremented by one
(or decremented by one if the maximum value is below the minimum
value). When the value reaches the maximum value (minimum value),
it will jump back to the minimum value (maximum value).
* This cannot be selected if the message type is Note.

6 Aftertouch mode (AFT Mode)
If the controller you’re editing is [A1]–[A8], you can specify the aftertouch setting.
Mode

Explanation

OFF

No aftertouch

Channel Pressure

Transmitted as channel pressure messages

Polyphonic Key Pressure

Transmitted as polyphonic key pressure messages.

25
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5 Keyboard range settings

Keyboard Set Window

Specify the lower limit of the UPPER part and the upper limit of the LOWER part.

fig.keyboarset-e.eps

1

2

3

4

5

6 [Transmit], [Receive]
Click [Transmit] if you want to save a keyboard set on the A-PRO. Click [Receive] if you
want to load a keyboard set from the A-PRO.

7 Setting buttons
Specify the button ([SPLIT]/[DUAL]/[LOWER]) for which you are assigning a keyboard
set.

8 [Close]
6

7

8

What is a Keyboard Set?
Keyboard-related settings such as the MIDI channel and split point for the
UPPER and LOWER parts, and the octave settings, are collectively called a
“keyboard set.”
You can use A-PRO Editor to make keyboard set settings and store them to the
[SPLIT]/[DUAL]/[LOWER] buttons.
* Keyboard sets cannot be stored on your computer.

1 Octave shift
Specifies the octave of the UPPER and LOWER parts.

2 Transpose
Specifies the transposition of the keyboard.

3 MIDI Channel
Specifies the MIDI channel of the UPPER and LOWER parts.

4 Active Part
Specifies the part(s) to which the [VALUE] knob, BENDER, MODULATION, AFTERTOUCH,
HOLD, or EXPRESSION will apply.

26

Closes the Keyboard Set window.
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Menus
File Menu

Options Menu
Menu

Explanation

New

Creates a new control map.
The new control map will have no MIDI messages assigned to any of
the controllers.

Open

Loads a control map that was saved in SMF format. For details, refer
to “Loading a Control Map that was Saved on Your Computer” (p. 32).

Save

Saves the control map currently being edited by overwriting the
SMF.

Save As

Saves the control map currently being edited in SMF format with the
name you specify. For details, refer to “Loading a Control Map that
was Saved on Your Computer” (p. 32).

Export Assign List

Exports an HTML-format list of the messages assigned to each controller of the control map currently being edited.
* The HTML file created by this command cannot be loaded by
means of the [File] menu command [Open].

View Assign list

Displays the assigned MIDI messages in your Web browser.

Recently Used Files

Shows the names of the recently used files.

Menu

Explanation

Show Keyboard Panel

Changes the settings of the [LOWER], [DUAL], or [SPLIT] keyboard
set.

MIDI Devices

Specifies the MIDI ports used to communicate with the A-PRO keyboard.
For details, refer to “MIDI Port Assignments” (p. 23).

Show Messages

Shows the MIDI message settings assigned to each controller in the
main window of A-PRO Editor. For details, refer to “Checking the Assigned MIDI Messages” (p. 30).

Help Menu
Menu
About

Explanation
Displays the version of A-PRO Editor.

Edit Menu
Menu

Explanation

Copy

Copies the setting of the selected controller to the clipboard.

Paste

Pastes the setting from the clipboard to the selected controller.

No Assign

Sets the MIDI assignment of the selected controller to No Assign.

27
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Keyboard Shortcuts
You can use the following keyboard shortcuts with A-PRO Editor.
Key
(Windows)

Command

Key
(Mac OS X)

[File]–[New]

Ctrl + N

Command + N

[File]–[Open]

Ctrl + O

Command + O

[File]–[Save]

Ctrl + S

Command + S

[File]–[Save As]

Ctrl + Shift + S

Command + Shift + S

[File]–[Exit]

Alt + F4

Command + Q

[Edit]–[Copy]

Ctrl + C

Command + C

[Edit]–[Paste]

Ctrl + V

Command + V

[Edit]–[NO ASSIGN]

Del

Del

Next controller

Ctrl + F

Command + F

Previous controller

Ctrl + B

Command + B

In text boxes such as the Title field of the main window, keyboard shortcuts for the
[Edit] menu commands [Copy] and [Paste] can be used on the text.

28
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Using Control Maps
Assigning MIDI Messages
Here’s how to assign a MIDI message to each controller.
fig.editor-assign1.eps

1

In the main window, click the
controller to which you want to
assign a MIDI message.

fig.editor-assign4.eps

4

In the Output Port field, specify
the MIDI output port.

5

If desired, enter a name in the
Name field.

6

Click [OK].

fig.editor-assign2.eps

2

In the message assignment
window, use the Assign Message
field to select the type of MIDI
message you want to assign.

fig.editor-assign3.eps

3

According to the type of MIDI
message you selected, use the
fields of the message assignment
area to specify the parameters.
For details on the parameters, refer to
“Message Parameters” (p. 33).

29
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Checking the Assigned MIDI Messages
You can use either of the following two methods to check the MIDI messages that are
assigned.

Indication

Meaning
NO ASSIGN

Viewing an assignment list

Note

If you want to use your Web browser to view an assignment list of the current control
map, choose the [File] menu command [View Assign List].
This is a convenient way to view all of the control map’s settings.
If you want to save the assignment list as an HTML file, choose the [File] menu
command [Export Assign List...]. When the “Save As” dialog box appears, specify the
location, assign a file name, and then click [Save].

Channel Pressure
Polyphonic Key Pressure
Control Change
Program Change
Program Change (Min-Max)

Viewing the assigned messages
If you want to see the current settings for each controller in the main window, choose
the [Options] menu command [Show Messages], and select the [Show Assigned
Messages] check box.
The current assignments will be shown in simplified form as follows.

Bank Select + Program Change
Program Change - Dec
Program Change - Inc

fig.editor-assignmessage.eps

RPN
NRPN
Encoder Simulate
System Realtime/F6
System Ex.
Free Message
Tempo

The display color indicates the output port setting.
Display color

30

Output Port

Yellow

Port 1

Light blue

Port 2

Light green

Port 1 + 2

Pink

NO ASSIGN
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Receiving a Control Map from the A-PRO

Transmitting a Control Map to the A-PRO

If you want to edit the control map settings of the A-PRO keyboard in A-PRO Editor, use
the following procedure to receive control map data from the A-PRO keyboard so that
it can be edited.
fig..editor-rcv1.eps

1

From the numbers displayed in the
[Control Map] dropdown list, select
the number of the control map that
you want to edit.

2

Click [Receive].

fig.editor-rev3-e.eps_50

3

In the confirmation dialog box, click
[Continue].

fig.editor-trans4-e.eps_40

4

A reception progress dialog box will
appear.
When the dialog box disappears, reception
has been completed.

If you want to use the control map settings created in A-PRO Editor on the A-PRO
keyboard, use the following procedure to transmit the edited control map to the A-PRO
keyboard.
fig.editor-trans1.eps

1

In the [Control Map] dropdown list,
specify the number at which you want
to save your control map.

2

Click [Transmit].

fig.editor-trans3-e.eps_50

3

In the confirmation dialog box, click
[Continue].

fig.editor-trans4-e.eps_40

4

A transmission progress dialog box
will appear.
When the dialog box disappears, transmission
has been completed.
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Saving a Control Map on Your Computer
Control map settings you’ve edited in A-PRO Editor can not only be transferred directly
between the A-PRO keyboard and your computer, they can also be saved on your
computer as an SMF format file.
To save an SMF file, proceed as follows.

1

Choose the [File] menu command [Save As].
If you want to overwrite the most recently opened file, choose the [File] menu
command [Save].

2

Enter a file name and click [Save].

Loading a Control Map that was Saved on Your
Computer
Control map data that was saved on your computer in SMF format can be loaded into
A-PRO Editor.
To load an SMF file, proceed as follows.

1

Choose the [File] menu command [Open].

2

Specify the SMF file that you want to load, and click [Open].
* An SMF file that does not contain A-PRO control map data cannot be opened. The
SMF must contain settings for all controllers.
* The contents of the Name field can be loaded only from an SMF that was saved by
A-PRO Editor.
* It is not possible to load control maps from the PCR-300/500/800 or memory sets
from an earlier PCR series unit.

32
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Message Parameters
The setting items shown in the message assign window will depend on the MIDI message you’ve selected. This section explains the setting items for each MIDI message. Values for parameters
are specified in decimal.
For details on the Settings field, refer to “Message Assignment Window” (p. 24).

NO ASSIGN
Clears any message assignment.
No message will be sent even if you operate a
controller that’s set to NO ASSIGN.
fig.editor-noassign.eps

Channel Message
Assigns a channel message.
Use the Type field to select the type of message you
want to assign. According to the message you’ve
selected, set the following parameters.

Channel Pressure
Assign a channel pressure message.
fig.editor-chpress.eps

Note
Assign a note message.
fig.editor-note.eps

Specify the following parameters.
There are no parameters to set.
* If HOLD, EXPRESSION, BENDER, MODULATION, or
AFTERTOUCH settings are set to NO ASSIGN, the
corresponding controller will control its own original
function. In this case, the current channel will be
used as the MIDI transmit channel.

Item

Specify the following parameters.
Item

Content

MIDI Channel

MIDI channel

Min Value

Lower value of channel pressure

Max Value

Upper value of channel pressure

Content

MIDI Channel

MIDI channel

Note Number

Note number

Velocity

Velocity

33

A-300_500_800C_e.book 34 ページ ２０１０年２月２２日

月曜日

午後９時１３分

Using A-PRO Editor

Channel Message
Polyphonic Key Pressure

Control Change

Program Change

Assign a polyphonic key pressure message.

Assign a control change message.

Assign a program change message (with a fixed
program number).

fig.editor-poly.eps

fig.editor-cc.eps

Specify the following parameters.
Item

Content

fig.editor-pc.eps

Specify the following parameters.
Item

Content

Specify the following parameters.
Item

Content

MIDI Channel

MIDI channel

MIDI Channel

MIDI channel

MIDI Channel

MIDI channel

Note Number

Note number

Control Number

Control number

PC Number

Program number

Min Value

Lower value of key pressure

Min Value

Lower limit of the control value

Max Value

Upper value of key pressure

Max Value

Upper limit of the control value

* The range of the program number is 1–128.
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Channel Message
Program Change (Min-Max)

Bank Select + Program Change

Program Change – Dec

Assign a program change message (with a variable
program number).

Assign a bank select message and program change
message (all values fixed).

Assign the program change decrement function (PC
DEC).
This will transmit a program change number that is one
less than the program change number most recently
transmitted in the A-PRO’s program change mode.

fig.editor-pcmm.eps

fig.editor-bankpc.eps

fig.editor-pcdec.eps

Specify the following parameters.
Item

Content

Specify the following parameters.
Item

Content

MIDI channel

MIDI Channel

MIDI channel

Min Number

Lower limit of the program number.

Bank MSB

Bank number MSB

Max Number

Upper limit of the program number.

Bank LSB

Bank number LSB

PC Number

Program number

MIDI Channel

* The range of the program number is 1–128.
* The range of the program number is 1–128.
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Channel Message
Program Change – Inc
Assign the program change increment function (PC
INC).
This will transmit a program change number that is one
greater than the program change number most
recently transmitted in the A-PRO’s program change
mode.

RPN

NRPN

Assign a registered parameter number.
fig.editor-rpn.eps

Assign a non-registered parameter number.
fig.editor-nrpn.eps

fig.editor-pcinc.eps

Specify the following parameters.
Item

Content

Item

Content

MIDI Channel

MIDI channel

MIDI Channel

MIDI channel

RPN MSB

RPN parameter number MSB

NRPN MSB

NRPN parameter number MSB

RPN LSB

RPN parameter number LSB

NRPN LSB

NRPN parameter number LSB

MSB Min Value

Lower limit of data entry MSB

MSB Min Value

Lower limit of data entry MSB

MSB Max Value

Upper limit of data entry MSB

MSB Max Value

Upper limit of data entry MSB

* The range for the data entry LSB is fixed at 0–127 and
cannot be changed.

36

Specify the following parameters.

* The range for the data entry LSB is fixed at 0–127 and
cannot be changed.
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Channel Message

System Realtime/F6

Encoder Simulate
Assign a function that simulates a rotary encoder.
fig.editor-encsim.eps

Assign a system realtime message or F6 (Tune Request).
fig.editor-realtime.eps

Specify the following parameters.
Item

For System Realtime/F6, use the Status field to choose
the message you want to assign.

Content

MIDI Channel

MIDI channel

Control Number

Controller number

* This can be assigned to a button, but will not do
anything.

Item

Content

F6

Tune request

F8

Timing clock

FA

Start

FB

Continue

FC

Stop

FF

System reset
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System Ex.

Table 1: Special characters used in the message entry field

Assign a system exclusive message (System Ex.).
You can enter up to twenty-four bytes.

Special
character

fig.editor-sysex.eps

Explanation

DT

Data insertion location

The data specified by Data Type will be inserted.

SS

Beginning of checksum
calculation

If you use the automatic checksum calculation function, use
this special character to specify the point at which checksum calculation is to begin.

S1/S2

Checksum insertion
location and type

If you use the automatic checksum calculation function, use
this special character to specify the point at which the
checksum is to be inserted, and its type.
S1: The most common type, used by Roland and other manufacturers.
S2: Choose this if a method other than S1 is used.

?n

Channel (? is any value
between 0–7)

If you want a channel number to be inserted in the exclusive
message, use this special character to specify its location
and the upper four bits (a fixed value of 0–7). The current
channel of the A-PRO will be inserted in the channel section.

?x

Block number (? is any
value between 0–7)

If you want a GS block number to be inserted in the exclusive message, use this special character to specify its location and the upper four bits (a fixed value of 0–7). The
current channel of the A-PRO will converted into the block
number and inserted.

Specify the following parameters.
Item

Content
You can enter a system exclusive message of up to twenty-four bytes.
Enter each byte as a hexadecimal value separated by a single-byte space.

Message entry field

The following limitations apply to the input.
* The message must begin with “F0” and end with “F7.”
* You cannot include more than one exclusive message.
* You cannot include messages other than an exclusive message.
You can enter variable data or a checksum using the special characters
described in “Table 1: Special characters used in the message entry field”
(p. 38). If you use the special character “DT,” use the Data Type field to
specify the type of data.

Details

Table 2: Types of data you can specify in the Data Type field
Data type

Data length

Target of the specified Min Value / Max Value

DT0: 7-bit

1 byte

Specifies a range from 0 to 127 (0–127)

DT1: 4-bit/4-bit

2 bytes

Specifies the range of the first byte (0–15)
* The second byte is fixed at 0–15

DT2: 7-bit/7-bit
(MSB/LSB)

2 bytes

Specifies the range of the MSB (0–127)
* The LSB is fixed at 0–127

DT3: 7-bit/7-bit
(LSB/MSB)

2 bytes

Specifies the range of the MSB (0–127)
* The LSB is fixed at 0–127

DT4: 4-bit/
4-bit/4-bit/4-bit

4 bytes

Specifies the range of change (0–255) between the negative direction (Min) and the positive direction (Max), centered on 8000h.

Data Type

If you’ve used the special character “DT” in the message entry field, use
this to specify the type of data to be inserted at that location. For the
types of data that can be specified, refer to “Table 2: Types of data you
can specify in the Data Type field” (p. 38).

Example of input

Min Value

Lower limit of the data value

1. Enter the following in the message entry field.

Max Value

Upper limit of the data value

F0 41 10 42 12 SS 40 1X 32 DT S1 F7

2. In the Data Type field, choose “DT0.” Specify the
Min Value as “0” and the Max Value as “127.”

38

Block number

1 byte

F0 41 10 42 12 SS 40 1x 32 DATA SUM F7

Address
Checksum calculation range

Data
Checksum
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Free Message

Tempo

Assign a MIDI message.
You can enter up to twenty-four bytes. You may assign more than one MIDI message if
desired.

Assign tempo control for transmitting MIDI CLOCK messages.
fig.editor-tempo.eps

fig.editor-freemsg.eps

There are no parameters to specify.
* This will not function if assigned to a button.
Specify the following parameters.
Item

Content
You can enter a MIDI message of up to twenty-four bytes. Enter each
byte as a hexadecimal value separated by a single-byte space.

Message entry field

The following limitations apply to the input.
* You can’t use a checksum.
* You can’t use a special character as the first byte.
You can also enter variable data using the special characters described in “Table 1: Special characters used in the message entry
field” (p. 38). If you use the special character “DT,” use the Data Type
field to specify the type of data.

Data Type

If you’ve used the special character “DT” in the message entry field,
use this to specify the type of data to be inserted at that location. For
the types of data that can be specified, refer to “Table 2: Types of
data you can specify in the Data Type field” (p. 38).

Min Value

Lower limit of the data value

Max Value

Upper limit of the data value
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Using Keyboard Sets
Receiving a Keyboard Set

Transmitting a Keyboard Set
If you want to use a keyboard set created in A-PRO Editor on the A-PRO keyboard,
proceed as follows to transmit it.

If you want to edit a keyboard set, use the following procedure to load the keyboard
map data from the A-PRO, so that it can be edited.
fig.keyboardset1.eps

1

Use the [SPLIT]/[DUAL]/[LOWER]
buttons to select the keyboard set
that you want to edit.

fig.keyboardsetrecv.eps

1

Use the [SPLIT]/[DUAL]/[LOWER]
buttons to select the keyboard set
that you want to edit.

fig.keyboardsettrans.eps

2

Click [Receive].

2

Click [Transmit].

3
4

In the confirmation box, click [Continue].

3
4

In the confirmation box, click [Continue].

A reception progress dialog box will appear.
When the dialog box disappears, reception is complete.

40

fig.keyboardset1.eps

A transmission progress dialog box will appear.
When the dialog box disappears, transmission is complete.
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Performing (Play Mode)
Use Play mode when you want to play the A-PRO’s keyboard or use its controllers to
control your software or sound modules.
Broadly speaking, the A-PRO has the following two modes.

Convenient Performance Functions
Here are some of the functions you will find convenient when you’re performing.

Mode

Explanation

To select

Play mode

This is the mode in which you play the keyboard
and operate the controllers.
MIDI messages will be transmitted by each controller.

1. Turn on the power.
2. Exit EDIT mode.

Edit mode
(p. 48, p. 57)

This is the mode in which you assign MIDI messages to each controller, or make system settings.

1. From PLAY mode, press the
[ACT] button and [
]
button simultaneously.

When you turn on the power, the A-PRO will start up in Play mode.
To return from Edit mode to Play mode, you can either press the [ACT] button and
[
] button simultaneously, or hold down the [SHIFT] button and press the [SPLIT]
button ([BS] button). In this case, the settings you were in the process of making will be
discarded.
When you play the keyboard in Play mode, note messages will be transmitted, causing
your sound module to produce sound.

Playing the Keyboard
1

Function

Explanation

Changing the pitch of
a sounding note
(Pitch Bend)

Moving the bender lever to the left or right will transmit pitch bend messages, causing the pitch to change slightly.
* The range of the pitch change (“bend range”) will depend on the settings of your sound module.

Applying modulation
to a sounding note
(Modulation)

Moving the bender lever away from yourself will transmit modulation
messages (CC#01), applying a vibrato effect to the sound.
* The way in which the sound changes will depend on the settings of your
sound module.

Switching the octave
(Octave Shift)

You can use the OCTAVE [–] [+] buttons to raise or lower the keyboard’s
pitch range in steps of an octave (Octave Shift). Use this when you want to
shift the keyboard’s pitch range upward or downward.
Pressing the OCTAVE [–] button once will lower the pitch by one octave.
Pressing it again will lower the pitch by another octave. You can adjust this
setting in a range of -4–5 octaves. Depending on the current octave shift
setting, the OCTAVE [–] or OCTAVE [+] button will light. By pressing the
OCTAVE [–] and OCTAVE [+] buttons simultaneously, you can reset the octave shift value to 0, restoring the keyboard to its original pitch.

Changing the pitch
(Transpose)

If you press the [TRANSPOSE] button to turn it on, the pitch will be shifted
by the number of semitone steps you specified using the EDIT mode
TRANSPOSE setting (p. 62).

Moving the bender lever toward the left while you play will lower the
pitch, and moving it toward the right will raise the pitch. This effect is
called “pitch bend.” Moving the lever away from yourself will apply
vibrato. This effect is called “modulation.”
If you move the lever to left or right and simultaneously move it away
from yourself, both effects will apply at the same time.

Specify the A-PRO’s current channel (MIDI transmit channel).
Set the A-PRO’s MIDI transmit channel to match the MIDI receive channel of your
sound module.
Setting the MIDI transmit channel is explained in “Specifying the Current Channel
(MIDI Transmit Channel)” (p. 42).

2

Use the A-PRO to select a sound on your sound module.

fig.PitchBend-e.eps

Selecting a sound on your sound module is explained in “Selecting Sounds
(PROGRAM CHANGE/BANK)” (p. 43).

3

* The amount of pitch change (bend
range) depends on the settings of your
sound module.

Play the A-PRO’s keyboard.
When you’ve finished making settings, play the keyboard in Play mode; MIDI
messages will be transmitted to your application.
* Since the A-PRO keyboard does not contain a sound generator, it cannot produce
sound on its own.

Pitch bend effect

Modulation effect

* If you assign a MIDI message to the
bender lever, the pitch bend effect and
modulation effect will be disabled.
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Specifying the Current Channel (MIDI Transmit Channel)
Here’s how to specify the current channel on which performance data from the keyboard will be transmitted.

What is the current channel?
The current channel is the MIDI transmit select for the keyboard and bender lever.
* Each controller can have its own separate transmit channel. However if “OMNI” is
ON, messages will be transmitted on the current channel specified for OMNI.

MIDI Channel
Here’s how to change the current channel (MIDI transmit channel).

What is OMNI?
If you turn OMNI on, all controllers will transmit on the current channel regardless of
their assigned MIDI transmit channel. If you want the MIDI transmit channel of the
controllers to also change when you switch the current channel, turn OMNI on as
follows.
1. Press the [ACT] button and [
] button simultaneously to enter Edit
mode.
The display will indicate “LCD CONTRAST.”

2. Turn the [VALUE] knob until “SYSTEM SETTING” appears in the display.
Press the [ENTER] button.

1

Use the [
] or [
“MIDI CH.”

] button to move the cursor in the display to

The display will indicate the current channel.

2

3. Turn the [VALUE] knob until “OMNI” appears in the display.
Press the [ENTER] button.
fig.lcd-omnisw.eps

4. The display will show the current setting.

Use the [VALUE] knob to specify the desired channel number.
You have now specified the current channel.

Item
OMNI OFF

Messages will be transmitted using the channel and port assigned for each
controller.

OMNI ON

Messages will be transmitted using the current channel and the KEYBOARD
PORT, regardless of the channel and port assigned for each controller.

Here’s another way to change the current channel.

1. Hold down the [SHIFT] button and use the following buttons to enter a
numerical value.
fig.numberbutton_play.eps

Controllers [B1]–[B4], [SPLIT]/[DUAL]/
[LOWER]/[UPPER] buttons, OCTAVE [–] [+]
buttons

2. Press the [ENTER] button.
With this, the numerical value you entered
is confirmed.

42

Explanation

5. Use the [VALUE] knob to select “ON” or “OFF.”
6. Press the [ENTER] button.
You’ll be returned to Play mode.
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Selecting Sounds (PROGRAM CHANGE/BANK)
You can transmit program changes to select sounds on your sound module from the A-PRO.
If you want to select a sound from a different bank, first use bank mode to transmit a bank
select message that will switch the bank. Then transmit a program change message. The
bank select message must be transmitted before the program change.

PROGRAM CHANGE
Here’s how to transmit a program change message on the current channel (p. 42).

1

Use the [
][
in the display.

] buttons to move the cursor to “PGM CHANGE”

The display will show the program change number that was transmitted most
recently.

Program change and bank select

2

By using program change messages in conjunction with bank select messages, MIDI
allows you to select among more than 128 sounds.
To switch to a sound that has the same bank number as the currently selected sound,
simply transmit a program change message.

Use the [VALUE] knob to specify the desired program change
number.
The program change message will be transmitted.

Bank Select (BANK)

To switch to a sound that has a different bank number, you’ll need to transmit a bank
number and a program number. The bank number is transmitted using two MIDI
messages: control change 0 (MSB) and control change 32 (LSB). To actually switch
sounds, transmit the bank number (MSB), bank number (LSB), and finally the program
number, in that order.

If you want to use the [VALUE] knob to switch the bank number, set the System setting
“FUNCTION” to “BANK LSB” or “BANK MSB.”
* For details, refer to “[VALUE] knob Settings” (p. 68).
Here’s how to transmit bank select (MSB, LSB) messages.

1

Use the [
][
the display.

] buttons to move the cursor to “USER ASSIGN” in

The display will show the bank select number that was transmitted most recently.

2

Use the [VALUE] knob to specify the desired bank select number.
Bank select (MSB, LSB) messages will be transmitted.
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Performing (Play Mode)

Selecting the UPPER and LOWER Sounds
The A-PRO’s keyboard provides two parts, UPPER and LOWER, and you can assign a different sound to each.

Selecting the UPPER Sound

Selecting the LOWER Sound
The entire keyboard will play the LOWER sound.

The entire keyboard will play the UPPER sound.
fig.Upper-e.eps

fig.Lower-e.eps

UPPER

1

Press the [UPPER] button so it’s lit.

1

Press the [LOWER] button so it’s lit.

2

Use the [
][
in the display.

2

Use the [
][
in the display.

3

Turn the [VALUE] knob.

3

Turn the [VALUE] knob.

] buttons to move the cursor to “PGM CHANGE”

The UPPER sound will change. When you play the keyboard, you’ll hear the sound
specified for UPPER.
* The [UPPER] button will be lit when you turn on the power.

44

LOWER

] buttons to move the cursor to “PGM CHANGE”

The LOWER sound will change. When you play the keyboard, you’ll hear the sound
specified for LOWER.
* The assignment of the [LOWER] button can be changed in A-PRO Editor’s keyboard
set window (p. 26).
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Performing (Play Mode)

Layering Two Sounds (DUAL)

Playing Two Sounds Separately (SPLIT)
The SPLIT button lets you play the UPPER sound in the range of C4 and above, while
playing the LOWER sound in the range of B3 and below.

The DUAL button lets you simultaneously play both the LOWER and UPPER sounds
from the entire keyboard.
fig.Dual-e.eps

fig.Split.eps

UPPER
LOWER
1

Press the [DUAL] button so it’s lit.
* If the cursor is at “PGM CHANGE” in the display, turning the [VALUE] knob will
change the UPPER sound.

B3

* To change the LOWER sound, set ACTIVE PART (p. 62) to LOWER. Then move the
cursor to “PGM CHANGE” and turn the [VALUE] knob.
* The assignment of the [DUAL] button can be changed in A-PRO Editor’s keyboard
set window (p. 26).

C4

LOWER
1

UPPER

Press the [SPLIT] button so it’s lit.
* If the cursor is at “PGM CHANGE” in the display, turning the [VALUE] knob will
change the UPPER sound.
* To change the LOWER sound, set Active Part (p. 62) to LOWER. Then move the
cursor to “PGM CHANGE” and turn the [VALUE] knob.
* The assignment of the [SPLIT] button can be changed in A-PRO Editor’s keyboard
set window (p. 26).
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Performing (Play Mode)

Adjusting the Playing Dynamics (VELOCITY)
Normally, note messages are transmitted with a velocity value that corresponds to the force with which you play the keyboard.
If desired, the A-PRO can also transmit notes with a fixed velocity value, regardless of your playing dynamics.
This is convenient when you want to record notes into your DAW software at a fixed velocity.
You can also adjust the sensitivity of the keyboard and change the velocity curve
(the way in which velocity responds to your dynamics).

Specifying a Fixed Velocity (KEY VELOCITY)
The system “FUNCTION” setting “KEY VELOCITY” lets you specify a fixed velocity.

Changing the Keyboard Touch (VELOCITY CURVE)
Refer to the system setting “KEYBOARD VELOCITY CURVE” (p. 60).

* You can use the following method, or refer to “[VALUE] knob Settings” (p. 68).
If “KEY VELOCITY” is assigned to the [VALUE] knob, you can also use the following
procedure to specify the velocity.

1

Use the [
][
the display.

] buttons to move the cursor to “USER ASSIGN” in

The display will indicate the velocity value that was transmitted most recently.

2

Use the [VALUE] knob to specify the desired velocity value
(TOUCH, 1–127).

fig.lcd-keyvelocity.eps

If the display indicates “TOUCH,” the
transmitted velocity value will correspond
to the force with which you play the
keyboard.

[VALUE] knob assignment
Here’s how to assign “KEY VELOCITY” as the “FUNCTION.”

1. Press the [ACT] button and [

] button simultaneously to enter Edit

mode.

2. Turn the [VALUE] knob until “FUNCTION” appears in the display.
Press the [ENTER] button.
fig.lcd-keyvelocity.eps

3. Use the [VALUE] knob to select “KEY
VELOCITY,” and then press the [ENTER]
button.
This completes the settings and takes you back to Play mode.
For more about FUNCTION, refer to “FUNCTION” (p. 68).
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Performing (Play Mode)

Muting the Controller Values (PRM MUTE)
You can mute all controllers so that MIDI messages will not be transmitted when
you move a controller.
This is useful in situations such as when a parameter value is far
away from the position of the controller; you can use the [PRM
MUTE] button to mute the controller, and then move the
controller near the parameter value to match the knob position
with the parameter value before you perform.

PRM MUTE
1

Press the [

][

] buttons simultaneously.

The “PRM MUTE” cursor will light in the display.

2

Operate a controller.
MIDI messages will not be transmitted even when you operate a controller.

3

Once again, press the [

][

] buttons simultaneously.

The “PRM MUTE” cursor in the display will go dark.
Now MIDI messages will once again be transmitted when you move a controller.
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Assigning MIDI Messages (EDIT Mode)
The A-PRO allows you to assign MIDI messages to each of its 44 controllers: [B1]–[B4], [R1]–[R9], [L1]–[L9], [S1]–[S9], [A1]–[A8], HOLD (P1), EXPRESSION (P2), BENDER, MODULATION, and
AFTERTOUCH. Edit mode is used to make MIDI message assignments. This section of the manual explains how to assign MIDI messages to the controllers using only the A-PRO keyboard.
You can also use A-PRO Editor to make assignments. For details, refer to “Using A-PRO Editor” (p. 22).

Assigning a MIDI Message on the A-PRO Keyboard
You can assign one of the following functions to each controller.
Function

48

See page

NOTE

p. 49

AFTERTOUCH

p. 50

CONTROL CHANGE

p. 51

PROGRAM CHANGE

p. 52

RPN

p. 53

NRPN

p. 53

TEMPO

p. 54

NO ASSIGN

p. 56

• If you want to assign a MIDI message to AFTERTOUCH, hold down the [ACT] button
and [
] button simultaneously, and then apply strong pressure to the keyboard.
• When you edit the assignment of a controller, the assignment is saved
automatically.
• You can copy an assigned message to another controller, or cancel an assignment.
For details, refer to “Copying an Assignment” (p. 56) or “Clearing an Assignment
(NO ASSIGN)” (p. 56).
* If you want to assign a system exclusive, a 1-byte system message (system realtime
messages, tune request), or any desired message of up to 24 bytes, you’ll need to use
A-PRO Editor.
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Assigning MIDI Messages (EDIT Mode)

Note Assignments
Here’s how to assign a note message to a controller. In addition to their use in performance, note messages can also be used to control DAW software.
MIDI transmit channel

Note number

Velocity

Port

Button mode

Aftertouch

1–16

0–127 (00–7FH)

100 (64H) (fixed)

PORT1 (fixed)

UNLATCH, LATCH

OFF (fixed)

1

Press the [ACT] button and [

2

Slightly move the controller to which you want to assign a note
message.

] button simultaneously.

If the controller is a button, press it.
The number of the selected controller will blink in the display.

3

Verify that the display, and press the [ENTER] button.

* If you assign a note message to [R1]–[R9], [S1]–[S9], or EXPRESSION (P2), setting the
controller to the maximum position will transmit a note message with the specified
velocity value. When you slightly lower the controller from its maximum position, a
note message with a velocity value of 0 will be transmitted.
* If you assign a note message to [B1]–[B4], [L1]–[L9], or HOLD (P1), turning the
controller On will transmit a note message with the specified velocity value. Turning
the controller Off will transmit a note message with a velocity value of 0.

fig.lcd-note.eps

4

Turn the [VALUE] knob until “NOTE”
appears in the display.

* If you assign a note message to [A1]–[A8], the velocity will change depending on the
force with which you strike the pad.

fig.lcd-midichannel

5

Press the [ENTER] button.
The display will indicate the currently
specified MIDI transmit channel.

6

Use the [VALUE] knob to specify the desired MIDI transmit channel.

fig.lcd-notenumber.eps

7

Press the [ENTER] button.
The display will indicate the currently
specified note number.

8
9
10

You can also use the following method to change the note number.
fig.numberbutton_edit.eps

In Edit mode, you can enter a numeric
value by pressing the following buttons.
Controllers [B1]–[B4], [SPLIT]/[DUAL]/
[LOWER]/[UPPER] buttons, OCTAVE [–] [+]
buttons

Use the [VALUE] knob to select the desired note number.
Press the [ENTER] button.
If the controller is [B1]–[B4], [L1]–[L9], [A1]–[A8], or HOLD (P1),
specify the desired “Button mode setting” (p. 55).

49

A-300_500_800C_e.book 50 ページ ２０１０年２月２２日

月曜日

午後９時１３分

Assigning MIDI Messages (EDIT Mode)

Aftertouch Assignment
Here’s how to assign an aftertouch message to a controller.
A-PRO Editor lets you assign aftertouch messages for individual notes (Polyphonic Key Pressure) as well as channel aftertouch (Channel Pressure) (p. 34).
MIDI transmit channel

Value range

Port

Button mode

1–16

0–127 (00–7FH)

PORT1 (fixed)

UNLATCH, LATCH, INCREASE

1

Press the [ACT] button and [

2

Slightly move the controller to which you want to assign aftertouch.

] button simultaneously.

If the controller is a button, press it.
The number of the selected controller will blink in the display.

3

Verify that the display, and press the [ENTER] button.

fig.lcd-aftertouch.eps

4

Turn the [VALUE] knob until
“AFTERTOUCH” appears in the
display.

fig.lcd-midichannel.eps

5

Press the [ENTER] button.
The display will indicate the currently
specified MIDI transmit channel.

6
7
8

50

Use the [VALUE] knob to specify the desired MIDI transmit channel.
Press the [ENTER] button.
Specify the “Button mode setting” (p. 55) as appropriate for the
controller type.
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Assigning MIDI Messages (EDIT Mode)

Control Change Assignment
Here’s how to assign a control change message to a controller.
MIDI transmit channel

Control change number

Port

Button mode

1–16

0–127 (00–7FH)

PORT1 (fixed)

UNLATCH, LATCH, INCREASE

1

Press the [ACT] button and [

2

Slightly move the controller to which you want to assign a control
change message.

] button simultaneously.

If the controller is a button, press it.
The number of the selected controller will blink in the display.

3

Verify that the display, and press the [ENTER] button.

fig.lcd-controlchange.eps

4

Turn the [VALUE] knob until
“CONTROL CHANGE” appears in the
display.

fig.lcd-midichannel.eps

5

Press the [ENTER] button.
The display will indicate the currently
specified MIDI transmit channel.

6

Use the [VALUE] knob to specify the desired MIDI transmit channel.

fig.lcd-ccnumber.eps

7

Press the [ENTER] button.
The display will indicate the currently
specified control change number.

8
9

Use the [VALUE] knob to select the desired control change number.
Press the [ENTER] button.
The display will indicate the currently specified control change number.

10

As appropriate for the type of controller, specify the desired “Button
mode setting” (p. 55) or “Virtual center click setting” (p. 55).
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Assigning MIDI Messages (EDIT Mode)

Program Change Assignment
Here’s how to assign a program change message to a controller.
MIDI transmit channel

BANK MSB

BANK LSB

Program number

Port

1–16

X

X

0–127 (00–7FH)

PORT1 (fixed)

1

Press the [ACT] button and [

2

Slightly move the controller to which you want to assign a control
change message.

] button simultaneously.

If the controller is a button, press it.
The number of the selected controller will blink in the display.

3

Verify that the display, and press the [ENTER] button.

fig.lcd-programchange.eps

4

Turn the [VALUE] knob until
“PROGRAM CHANGE” appears in the
display.

fig.lcd-midichannel.eps

5

Press the [ENTER] button.
The display will indicate the currently
specified MIDI transmit channel.

6

Use the [VALUE] knob to specify the desired MIDI transmit channel.

fig.lcd-pcnumber.eps

7

Press the [ENTER] button.
The display will indicate the currently
specified program change number.

8

Use the [VALUE] knob to select the desired program change
number.

9

Press the [ENTER] button.
If you’ve assigned this message to [R1]–[R9], [S1]–[S9], or EXPRESSION (P2), moving
the controller to the maximum position will transmit the program change message
you specified.
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Assigning MIDI Messages (EDIT Mode)

RPN/NRPN Assignment
Here’s how to assign an RPN or NRPN to a controller.
Data entry MSB (CC#6) range

Data entry LSB (CC#38) range

Port

0–127 (00–7FH)

not transmitted

PORT1

1

Press the [ACT] button and [

2

Slightly move the controller to which you want to assign a control
change message.

] button simultaneously.

If the controller is a button, press it.
The number of the selected controller will blink in the display.

3

Verify that the display, then press the [ENTER] button.

fig.lcd-rpn.eps

4

Turn the [VALUE] knob until “RPN”
appears in the display.
* If you want to assign an NRPN message, get “NRPN” to appear in the display. The
rest of the procedure is the same as for RPN.

fig.lcd-midichannel.eps

5

Press the [ENTER] button.
The display will indicate the currently
specified MIDI transmit channel.

6
7

Use the [VALUE] knob to specify the desired MIDI transmit channel.
Press the [ENTER] button.

fig.lcd-rpnmsb.eps

8

Use the [VALUE] knob to select the
desired RPN MSB (CC#101) or NRPN
MSB (CC#99).

9
10

Press the [ENTER] button.

11
12

Press the [ENTER] button.

Use the [VALUE] knob to select the desired RPN LSB (CC#100) or
NRPN LSB (CC#98).
As appropriate for the controller type, specify the desired “Button
mode setting” (p. 55) or “Virtual center click setting” (p. 55).
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Assigning MIDI Messages (EDIT Mode)

Tempo Assignment
You can assign the MIDI CLOCK speed (20–250) to a controller.
In order to transmit MIDI CLOCK, the MIDI CLOCK setting must be “ON.”
➝ “MIDI CLOCK ON/OFF” (p. 64)

1

Press the [ACT] button and [

2

Slightly move the controller to which you want to assign tempo.

] button simultaneously.

If the controller is a button, press it.
The number of the selected controller will blink in the display.

3

Verify that the display, and press the [ENTER] button.

fig.lcd-tempo.eps

4
5

Turn the [VALUE] knob until
“TEMPO” appears in the display.
Press the [ENTER] button.
* If the controller is a button, the tempo will be maximum (250) when on, and
minimum (20) when off.
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Button mode setting

Virtual center click setting

In Edit mode, when you assign a message to a button as described in “Assigning a MIDI
Message on the A-PRO Keyboard” (p. 48), you can specify how the button will operate
(the “button mode”).
If a button is assigned as a controller, the maximum value will be transmitted when the
button is turned on, and the minimum value will be transmitted when the button is
turned off.

1

In Edit mode, when you assign a message to a knob [R1]–[R9] or a slider [S1]–[S9] as
described in “Assigning a MIDI Message on the A-PRO Keyboard” (p. 48), you can turn
the Virtual Center Click setting on or off.

1

Mode

Use the [VALUE] knob to select either UNLATCH, LATCH, or
INCREASE.
Mode

Explanation

UNLATCH

Pressing the button turns the function on; releasing the button turns
the function off. The button will light while held down.

Turn the [VALUE] knob to choose On or Off.

Off

The value will change smoothly between minimum and maximum
values.

On

The value will remain at the center value (64) in the middle region of
the controller.

64

63

2

LATCH

The function will alternately turn on/off each time you press the button. The button will light when an On message is transmitted, and will
go out when an Off message is transmitted.

INCREASE

Each time you press the button, the value will be incremented by one
(or decremented by one if the minimum value is lower than the maximum value). When the value reaches the maximum value (minimum
value), it will wrap around to the minimum value (maximum value).
The button will light only while held down.

0

2

Explanation

fig.VirtualCenterClick-e.eps

65

127

The A-PRO’s knobs and sliders do not have a center click.
However if you turn the Virtual Center Click function on, they will
be given a “virtual” center click so that a broader range in the
center of the controller’s range of motion will produce the
center value.

Press the [ENTER] button.

Press the [ENTER] button.
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Assigning MIDI Messages (EDIT Mode)

Convenient Functions
Copying an Assignment

Clearing an Assignment (NO ASSIGN)

By using this function, a message assigned to a controller can be copied to a different
controller.
For example, if you want to assign similar messages to multiple controllers, assign the
desired MIDI message to one of the controllers, and then use this function to copy that
message to the assignment of the other controllers.
* Unexpected results may occur if you copy an assigned message between controllers
of different types (e.g., between a button and a knob).
For example, if a note message assigned to a pad is copied to a knob, the result will
not be as you expect.
If a rotary encoder simulation assigned to a knob is copied to a button, it will not
operate.
When copying an assigned message, please be aware of the controller types and the
content of the message.

1

Simultaneously press the [ACT] button and the [

2

Choose the copy-destination controller, and move it slightly.

Here’s how to clear the MIDI message assigned to a controller. No MIDI message will be
transmitted when you move a controller whose assignment was cleared.
If you clear the assignment for bender, modulation, aftertouch
(AFTERTOUCH), HOLD (P1), or EXPRESSION (P2), the respective
controller will control its own original function. In this case, it will use
the current channel as its MIDI transmit channel.

1

Simultaneously press the [ACT] button and the [

2

Choose the controller whose assignment you want to clear, and
move it slightly.
If it’s a button, press it. The controller number will appear in the display.

3

] button.

Verify that the correct controller number is shown in the display,
and press the [ENTER] button.

fig.lcd-noassign.eps

If it’s a button, press it. The controller number will appear in the display.

3
4

Slightly move the copy-source
controller. If it’s a button, press it.
The display will indicate the copy-source
and copy-destination controller numbers.

5

56

4

Make sure that the display indicates and press the [ENTER] button.

fig.lcd-copyfromto.eps

Verify in the display, and press the [ENTER] button.

] button.

Turn the [VALUE] knob until “NO
ASSIGN” appears in the display,
then press the [ENTER] button.

fig.lcd-yes.eps

5

The indication “YES” will blink in the
display; press the [ENTER] button
once again.
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System Settings (EDIT Mode)
This section explains how to make system settings for the A-PRO.
System settings include the following items.
Category
LCD

Item

Contents

Factory setting

See page

LCD CONTRAST

Adjusts the LCD contrast.

5

p. 59

KEYBOARD VELOCITY CURVE

Specifies how velocity will change in response to keyboard dynamics (velocity curve).

1-MEDIUM

p. 60

KEYBOARD AFTERTOUCH CURVE

Specifies how keyboard aftertouch will respond.

1

p. 61

KEYBOARD PORT SET

Specifies the port from which the keyboard and bender lever will transmit performance data.

PORT 1

p. 61

KEYBOARD ACTIVE PART

Specifies the part(s) that will be affected by the [VALUE] knob, BENDER, MODULATION, AFTERTOUCH,
HOLD, and EXPRESSION controllers.

UPPER

p. 62

TRANSPOSE

Specifies how the keyboard will be transposed when you turn on the [TRANSPOSE] button.

2

p. 62

SHIFT KEY LATCH

Specifies whether the [SHIFT] button will operate in Unlatched mode (turning on when pressed, turning off
when released) or in Latched mode (alternately turning on/off each time it is pressed).

UNLATCH

p. 62

PAD VELOCITY CURVE

Specifies how the velocity value transmitted when you strike a pad controller [A1]–[A8] will correspond to
the force with which you strike (velocity curve).

1

p. 63

PAD AFTERTOUCH CURVE

Specifies how the pad controllers [A1]–[A8] will respond to aftertouch.

1

p. 63

MIDI CLOCK ON/OFF

Specifies whether MIDI CLOCK will be transmitted.

OFF

p. 64

MIDI CLOCK DEFAULT TEMPO

Specifies the initial MIDI CLOCK value when “MIDI CLOCK ON/OFF” is On. After the power is turned on, this
tempo will be output until you move the [VALUE] knob to which TEMPO is assigned.

120

p. 64

MIDI CLOCK OUTPUT PORT

When “MIDI CLOCK ON/OFF” is On, this specifies the port from which MIDI CLOCK is transmitted.

PORT 1

p. 64

ADVANCED DRIVER MODE

Switches the driver mode.

ON

p. 65

MIDI I/F SWITCH

Specifies whether the MIDI connectors will be used as a MIDI interface.

ON

p. 66

MIDI MERGE DESTINATION

Specifies the port that will be merged when the [MIDI MERGE] switch is On.

PORT 1

p. 67

Control map

STARTUP MEMORY

Specifies which control map is to be called up when the power is turned on.

CTL MAP 0

p. 68

Controller

FUNCTION

Specifies the parameter that will be transmitted by the [VALUE] knob.

KEY VELOCITY

p. 68

Keyboard

Pads

Clock

USB
MIDI
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Category

Item

Contents

Factory setting

See page

H-ACTIVITY ON/OFF

Turn this on when using specific applications (such as Pro Tools LE). If this is On, the message “90 00 7F” will
be transmitted from “A-PRO 2” at intervals of approximately 500 ms.

OFF

p. 69

L9 FUNCTION

Specifies the function of the [HOLD] button.

HOLD

p. 69

OMNI

If OMNI is On, all controllers will always transmit on the current channel, regardless of the MIDI transmit
channel setting that is assigned to the controller.

OFF

p. 42

FACTORY RESET

Returns the A-PRO to the factory-set condition.

–

p. 70

Other
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LCD Contrast Setting
LCD CONTRAST
If you find the text in the display difficult to read, you can adjust the contrast as follows.
The brightness of the screen may be affected by environmental conditions such as
temperature.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “LCD CONTRAST,” and press the
[ENTER] button.

3

Use the [VALUE] knob to adjust the contrast.

] button.

This setting has a range of 1–10. Higher values make the display brighter.

4

Press the [ENTER] button to return to Play mode.
You can also change the LCD contrast in the following way.

fig.numberbutton_edit.eps

In Edit mode, press the following buttons
to enter a numerical value.
Controllers [B1]–[B4], [SPLIT]/[DUAL]/
[LOWER]/[UPPER] buttons, OCTAVE
[–] [+] buttons
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Keyboard-related Settings
KEYBOARD VELOCITY CURVE
Here’s how to change the velocity curve, which specifies how the transmitted velocity
value will correspond to your keyboard playing dynamics.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “KEYBOARD/PAD,” and press the
[ENTER] button.

] button.

Number

Setting

1

1-LIGHT

2

1-MEDIUM

fig.lcd-KBDVELOCURVE.eps

3

Use the [VALUE] knob to select “KBD
VELO CURVE,” and press the [ENTER]
button.

3

1-HEAVY

4

Use the [VALUE] knob to select the desired KEYBOARD VELOCITY
CURVE.

4

2-LIGHT

The name of the selected setting is shown in the display.

5

2-MEDIUM

5

Press the [ENTER] button to return to Play mode.
6

2-HEAVY

7

3-LIGHT

8

3-MEDIUM

9

3-HEAVY

10

4-LIGHT

11

4-MEDIUM

12

60

4-HEAVY

Type of curve

Keyboard sensitivity
Higher velocity values (volume)
can be produced even if you play
softly.

1
These are the most typical settings. Your keyboard playing
dynamics will produce the
most natural volume change.

Keyboard sensitivity will be typical.
Higher velocity values (volume)
will not be produced unless you
play strongly.
Higher velocity values (volume)
can be produced even if you play
softly.

2
Compared to curve 1, these
curves allow greater volume
change without having to
play very strongly.

Keyboard sensitivity will be typical.
Higher velocity values (volume)
will not be produced unless you
play strongly.
Higher velocity values (volume)
can be produced even if you play
softly.

3
These curves make it easy to
play consistently, with minimal change produced by your
playing dynamics.

Keyboard sensitivity will be typical.
Higher velocity values (volume)
will not be produced unless you
play strongly.
Higher velocity values (volume)
can be produced even if you play
softly.

4
Compared to curve 1, these
curves produce greater volume change when you play
strongly.

Keyboard sensitivity will be typical.
Higher velocity values (volume)
will not be produced unless you
play strongly.
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KEYBOARD AFTERTOUCH CURVE

KEYBOARD PORT SET

Here’s how to specify the way that keyboard aftertouch will respond.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “KEYBOARD/PAD,” and press the
[ENTER] button.

Here’s how to specify the port from which performance data for the keyboard and
bender lever will be transmitted.

] button.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “KEYBOARD/PAD,” and press the
[ENTER] button.

fig.lcd-KBDAFTCHCURVE.eps

3
4

Use the [VALUE] knob to select “KBD
AFTCH CURVE,” and press the
[ENTER] button.

fig.lcd-KBDPORTSET.eps

Use the [VALUE] knob to select the desired KEYBOARD
AFTERTOUCH CURVE.

3

Use the [VALUE] knob to select “KBD
PORT SET,” and press the [ENTER]
button.

4

Use the [VALUE] knob to select the desired KEYBOARD PORT.

The value of the selected setting is shown in the display.
Number

Curve type

1

1

2

2

3

3

] button.

The value of the selected setting is shown in the display.

Explanation

Number

This is the most typical curve. The pressure you apply to
the keyboard and the resulting aftertouch effect will correspond in the most natural way.

Compared with curve 1, higher aftertouch values will be
transmitted even when you apply light pressure to the
keyboard.

5

Setting

Explanation

1

PORT 1

Messages will be transmitted to “A-PRO 1.”

2

PORT 2

Messages will be transmitted to “A-PRO 2.”

3

PORT 1+2

Messages will be transmitted to “A-PRO 1” and “A-PRO 2.”

Press the [ENTER] button to return to Play mode.

There will be little change in aftertouch when you apply
pressure to the keyboard, making it easier for you to perform.

Compared with curve 1, aftertouch will be applied when
you apply greater pressure to the keyboard.

4

4

5

Press the [ENTER] button to return to Play mode.
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KEYBOARD ACTIVE PART

SHIFT KEY LATCH

Here’s how to specify the part that will be affected by the [VALUE] knob, BENDER,
MODULATION, AFTERTOUCH, HOLD, and EXPRESSION controllers.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “KEYBOARD/PAD,” and press the
[ENTER] button.

This specifies whether the [SHIFT] button will operate in Unlatch mode (On when held
down, Off when released), or in Latch mode (turns On/Off each time the button is
pressed).

] button.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “KEYBOARD/PAD,” and press the
[ENTER] button.

fig.lcd-KBDACTIVEPART.eps

3

Use the [VALUE] knob to select “KBD
ACTIVE PART,” and press the
[ENTER] button.

fig.lcd-SHIFTKEYLATCH.eps

3

fig.lcd-KBDACTIVEPART1.eps

4

Use the [VALUE] knob to select
“UPPER” or “LOWER.”

5

Press the [ENTER] button to return to Play mode.

fig.lcd-SHIFTKEYLATCH1.eps

TRANSPOSE
Here’s how to specify the amount by which the keyboard will be transposed when you
press the [TRANSPOSE] button to turn it on.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “KEYBOARD/PAD,” and press the
[ENTER] button.

fig.lcd-TRANSPOSE.eps

3

Use the [VALUE] knob to select
“TRANSPOSE,” and press the
[ENTER] button.

fig.lcd-TRANSPOSE1.eps

4

Use the [VALUE] knob to specify the
transposition value.
You can specify a value in the range of -6 to
5 (semitones).

5

62

Press the [ENTER] button to return to Play mode.

Use the [VALUE] knob to select
“SHIFT KEY LATCH,” and press the
[ENTER] button.

] button.

4

Use the [VALUE] knob to choose
“OFF” or “ON.”

5

Press the [ENTER] button to return
to Play mode.

] button.
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Pad-related Settings
PAD VELOCITY CURVE

PAD AFTERTOUCH CURVE
Here’s how to specify the way in which the pressure you apply to the pads will
correspond to the aftertouch data that is produced.

Here’s how to specify the way in which the force of your strike on the controller pads
[A1]–[A8] will affect the velocity that is transmitted.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “KEYBOARD/PAD,” and press the
[ENTER] button.

] button.

fig.lcd-PADVELOCURVE.eps

3

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “KEYBOARD/PAD,” and press the
[ENTER] button.

3

Use the [VALUE] knob to select “PAD
AFTCH CURVE,” and press the
[ENTER] button.

fig.lcd-PADAFTCHCURVE1.eps

4

Use the [VALUE] knob to select the
desired PAD VELOCITY CURVE.
The number of the selected setting is shown
in the display.
Number

Type of curve

1

1

2

Use the [VALUE] knob to select the
desired PAD AFTERTOUCH CURVE.
The number of the selected setting is shown
in the display.

Result

Number

This is the most typical curve. The force with which you
strike the pad will correspond to the volume in the most
natural way.

1

Compared to curve 1, there will be greater volume
change for softer strikes on the pad.

2

3

3

4

Type of curve

1

2

2
Pad playing dynamics will produce little change in velocity, making it easier for you to perform at a consistent
volume.

3

Compared with curve 1, striking the pads more strongly
will produce greater change in velocity.

4

3

4

5

] button.

fig.lcd-PADAFTCHCURVE.eps

Use the [VALUE] knob to select “PAD
VELO CURVE,” and press the [ENTER]
button.

fig.lcd-PADVELOCURVE1.eps

4

1

Press the [ENTER] button to return to Play mode.

Result
This is the most typical curve. The pressure you apply to
the pad will correspond to the aftertouch value in the
most natural way.

Compared to curve 1, there will be more change in the
aftertouch value starting with softer pressure on the
pad.

Pressure applied to the pad will produce little change in
aftertouch value, making it easier for you to produce
consistent aftertouch effects.

Compared with curve 1, you will need to apply stronger
pressure on the pad in order to produce aftertouch.

4

5

Press the [ENTER] button to return to Play mode.
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Clock-related Settings
MIDI CLOCK ON/OFF

MIDI CLOCK OUTPUT PORT

Here’s how to specify whether MIDI CLOCK will be transmitted.

This setting specifies the port from which MIDI clock will be output when “MIDI CLOCK
ON/OFF” is On.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “MIDI CLOCK,” and press the [ENTER]
button.

3

Use the [VALUE] knob to select “MIDI CLK ON/OFF,” and press the
[ENTER] button.

4
5

] button.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “MIDI CLOCK,” and press the [ENTER]
button.

fig.lcd-CLKOUTPUTPORT.eps

3

Use the [VALUE] knob to select “ON” or “OFF.”

] button.

Press the [ENTER] button to return to Play mode.

Use the [VALUE] knob to select “CLK
OUTPUT PORT,” and press the
[ENTER] button.

fig.lcd-CLKOUTPUTPORT1.eps

4

MIDI CLOCK DEFAULT TEMPO
This setting specifies the default MIDI clock value when “MIDI CLOCK ON/OFF” is On.
After you turn on the power, this tempo will be output until you move the VALUE
controller to which Tempo is assigned.

Use the [VALUE] knob to specify the
MIDI CLOCK OUTPUT PORT.
The display will indicate the port you
specified.

5

Press the [ENTER] button to return to Play mode.
Number

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “MIDI CLOCK,” and press the [ENTER]
button.

3

Use the [VALUE] knob to select “DEFAULT TEMPO,” and press the
[ENTER] button.

4

Use the [VALUE] knob to specify the MIDI CLOCK DEFAULT TEMPO
value in a range of 20–250.
The display will indicate the value you specified.

5

64

] button.

Press the [ENTER] button to return to Play mode.

Setting

Explanation

1

PORT 1

MIDI CLOCK will be transmitted from “A-PRO 1.”

2

PORT 2

MIDI CLOCK will be transmitted from “A-PRO 2.”

3

1AND2

MIDI CLOCK will be transmitted from “A-PRO 1” and “A-PRO 2.”
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USB-related Settings
ADVANCED DRIVER MODE
Here’s how to turn ADVANCED DRIVER MODE on/off.
We recommend that you normally leave this On.
If you change this setting, the new setting will take force after you’ve turned the power
off, then on again.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “USB SETTING,” and press the
[ENTER] button.

3

Use the [VALUE] knob to select “USB ADV DRIVER,” and press the
[ENTER] button.

4

Use the [VALUE] knob to specify the USB MIDI driver type.
Setting

] button.

Explanation

OFF

Choose this if you want to use the standard MIDI driver provided by your
operating system (p. 73). (Standard driver mode)

ON

This setting uses FPT technology to allow high-speed MIDI communication. Choose this if you’ve installed the driver as described in p. 12 and
following.

* FPT = Fast Processing Technology of MIDI Transmission
This takes full advantage of the USB bandwidth to process MIDI data in an optimal
way at all times, depending on the amount of MIDI data to be transmitted.

5

Press the [ENTER] button to return to Play mode.
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MIDI-related Settings
MIDI I/F SWITCH
This setting specifies whether the MIDI connectors will be used as a MIDI interface.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “MIDI SETTING,” and press the
[ENTER] button.

] button.

Setting

3

Use the [VALUE] knob to select “MIDI I/F SWITCH,” and press the
[ENTER] button.

4

Use the [VALUE] knob to specify the MIDI I/F setting.
The display will indicate the value you selected.

5

Press the [ENTER] button to return to Play mode.

Explanation

MIDI I/F MODE OFF

OFF

MIDI messages received by the A-PRO
keyboard will not be transmitted from the
A-PRO. MIDI messages will be exchanged
between the A-PRO and the computer, and
between the A-PRO and the external MIDI
device.

MIDI OUT device
A-PRO MIDI OUT

X

MIDI IN device
A-PRO MIDI IN

MIDI OUT

BULK reception

A-PRO
USB

X

A-PRO 1

MIDI IN

PORT 1
PORT 2/
BULK transmission

A-PRO 2

MIDI messages

MIDI I/F MODE ON

ON

The A-PRO keyboard’s MIDI connectors will
operate as a MIDI interface. MIDI messages
from the computer connected via USB to the
A-PRO will be transmitted to a sound module
connected to the A-PRO’s MIDI OUT
connector. MIDI messages from a MIDI
device connected to the A-PRO’s MIDI IN
connector will be sent to the computer.

MIDI OUT device
A-PRO MIDI OUT

MIDI OUT
BULK reception

A-PRO
MIDI IN device
A-PRO MIDI IN

USB
MIDI IN

A-PRO 1

PORT 1

A-PRO 2

PORT 2/
BULK transmission

MIDI messages
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MIDI MERGE DESTINATION
The A-PRO provides a [MIDI MERGE] switch (p. 11). Here’s how to specify the port that will be merged as the MIDI MERGE DESTINATION when the [MIDI MERGE] switch is On.
The MIDI MERGE function is convenient when an external MIDI controller other than the A-PRO is connected to the A-PRO’s MIDI IN connector.
For example, you might connect a second A-PRO unit, and use one A-PRO to play a software synthesizer while using the other A-PRO unit to control your DAW software.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “MIDI SETTING,” and press the
[ENTER] button.

] button.

3

Use the [VALUE] knob to select “MIDI MERGE DEST,” and press the
[ENTER] button.

4

Use the [VALUE] knob to specify the desired MIDI merge
destination.

Number

Setting

Explanation

1

PORT1

Messages received at MIDI IN will be merged into the A-PRO’s PORT 1.

2

PORT2

Messages received at MIDI IN will be merged into the A-PRO’s PORT 2.

3

MIDI OUT

Messages received at MIDI IN will be merged into the A-PRO’s MIDI
OUT.

The display will indicate the value you selected.

5

Press the [ENTER] button to return to Play mode.

MIDI MERGE switch and MIDI MERGE DESTINATION
fig.MIDI-MERGE.eps

MIDI I/F MODE ON
MIDI OUT device
A-PRO MIDI OUT

MIDI OUT
BULK reception

A-PRO
MIDI IN device
A-PRO MIDI IN

USB

A-PRO 1
A-PRO 2

MIDI OUT

OFF

PORT 1

PORT 1

ON

PORT 2/
BULK transmission

PORT 2

MIDI IN

MIDI messages
[MIDI MERGE] switch
MIDI MERGE DESTINATION
In this illustration, the [MIDI MERGE] switch is On and the MIDI MERGE DESTINATION is set to Port 2, so that messages received at MIDI IN are merged with the messages of Port 2 and sent to
the computer.
* If you turn the [MIDI MERGE] switch On, no messages will arrive even if you’ve selected A-PRO MIDI IN as the MIDI IN device on your computer.
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Control Map Settings

[VALUE] knob Settings

STARTUP MEMORY

FUNCTION

Here you can specify which control map is to be called up when the A-PRO is powered up.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “SYSTEM SETTING,” and press the
[ENTER] button.

Here you can specify the function that is to be controlled by the [VALUE] knob when
the cursor is located at USER ASSIGN.

] button.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “FUNCTION,” and press the [ENTER]
button.

fig.lcd-STARTUPMEMORY.eps

3

Use the [VALUE] knob to select
“STARTUP MEMORY,” and press the
[ENTER] button.

fig.lcd-FUNCKEYVELO.eps

3

Use the [VALUE] knob to choose the
parameter that will be assigned to
the [VALUE] knob.

4
5

Press the [ENTER] button.

6

Press the [ENTER] button.

fig.lcd-STARTUPMEMORY1.eps

4

Use the [VALUE] knob to choose
“CTL MAP 0” or “LAST ACC MAP.”
Setting

5

68

] button.

Explanation

CTL MAP 0

Control map number 0 will be selected at start-up.

LAST ACC MAP

The control map that was last selected and saved will be called up
upon start-up.

If you selected “CONTROL CHANGE” as the parameter, use the
[VALUE] knob to specify the desired control change number.

Value

Setting

Explanation

Value range
TOUCH, 1–127
* If you choose
TOUCH, the
transmitted
velocity value
will depend
on your keyboard playing
strength.

1

KEY VELOCITY

Fixes the key velocity value.
The A-PRO detects the force with
which you play the keyboard, and
transmits this as the velocity value;
however, this setting causes a fixed
velocity to be transmitted regardless of how strongly you strike the
keyboard. Use this if you don’t want
your playing dynamics to have an
effect.

2

BANK LSB

Specifies the bank select LSB
(CC#32).

0–127

3

BANK MSB

Specifies the bank select MSB
(CC#00).

0–127

4

CONTROL
CHANGE

Specifies a control change.

0–127

5

TEMPO

Specifies the MIDI CLOCK tempo.

20–250

Press the [ENTER] button.
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Other Settings
H-ACTIVITY ON/OFF

L9 FUNCTION

Turn this On when using certain applications (such as Pro Tools LE). If this is On, the
message “90 00 7F” will be transmitted to “A-PRO 2” at intervals of approximately 500
ms.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “SYSTEM SETTING,” and press the
[ENTER] button.

This specifies the function of the [HOLD] button.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “SYSTEM SETTING,” and press the
[ENTER] button.

] button.

fig.lcd-L9FUNC.eps

3

fig.lcd-HACTVTY.eps

3

Use the [VALUE] knob to choose
“H-ACTVTY ON/OFF,” and press the
[ENTER] button.
Use the [VALUE] knob to specify
either “ON” or “OFF.”

5

Press the [ENTER] button.

Use the [VALUE] knob to choose “L9
FUNCTION,” and press the [ENTER]
button.

fig.lcd-L9FUNC1.eps

4

fig.lcd-HACTVTY1.eps

4

] button.

Use the [VALUE] knob to specify the
function of [HOLD] button.
Value

5

Setting

Explanation

1

L9

Any desired MIDI message can be assigned to the button.

2

HOLD

The button will allow the sound to continue even after you
take your hand off the pad.

3

VLINK

The button will operate as a V-LINK ON/OFF button.

Press the [ENTER] button.
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OMNI
Refer to “What is OMNI?” (p. 42).

FACTORY RESET
This will return the A-PRO to its factory-set condition.

1

Simultaneously press the [ACT] button and the [

2

Use the [VALUE] knob to select “FACTORY RESET,” and press the
[ENTER] button.

] button.

“SURE?” will appear, blinking, in the display.
fig.lcd-RESETSURE.eps

3

If you are sure that you want to
execute the factory reset operation,
press the [ENTER] button.
“FACTORY RESET” will appear, blinking, in the display while the factory reset
operation is being carried out.
Once the factory reset is complete, “COMPLETE!” will appear in the display. You’ll
then be returned to Play mode.
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]

Two MIDI Ports
If the A-PRO is connected to your computer via USB, the A-PRO will be able to use two MIDI output ports (PORT 1 and PORT 2). Each controller of the A-PRO can be assigned to send its MIDI
messages to either port.
For details on how to make this assignment, refer to “Using Control Maps” (p. 29) or “Assigning a MIDI Message on the A-PRO Keyboard” (p. 48).
fig.MIDI-port1-e.eps

DAW software
Track
PORT1

A-PRO 1

A-PRO

THRU

MIDI sound module
MIDI OUT

:

Recorded
on a track
PORT2

Software
synthesizer

If you’re using DAW software, and you’re simply controlling the sound module for the part that’s
producing the sound, the A-PRO’s controllers can use the same MIDI output port as the keyboard.
When the A-PRO is in the default state, the A-PRO’s keyboard performance data will also be sent
from PORT 1, so you can assign the controllers to PORT 1 as well.

A-PRO 2

fig.MIDI-port2-e.eps

Some DAW software has an input port used to control the mixer section of the DAW software.
Since the A-PRO has two MIDI output ports, you can use one port to play sounds and control the
sound module, while using the other port to control your DAW software.

DAW software
Track
PORT1

A-PRO 1

A-PRO

THRU

MIDI OUT

:

Recorded
on a track
PORT2

Software
synthesizer

A-PRO 2

fig.MIDI-port3-e.eps

DAW software
Track
PORT1

A-PRO 1

A-PRO

THRU

MIDI sound module
MIDI OUT

For example, if you want to use the A-PRO’s [A1]–[A8] buttons to switch sounds on your sound
module, and use the [S1]–[S9] sliders to control the volume faders of your DAW software’s mixer,
you could assign the controllers to MIDI output ports as follows.

:

Recorded
on a track
PORT2

Software
synthesizer

[A1]–[A8] buttons: PORT 1
[S1]–[S9] sliders: PORT 2

A-PRO 2

* For details on how to control your DAW software, refer to the owner’s manual for the DAW
software you’re using.
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Connecting the A-PRO Directly to a Sound Module
You can connect the A-PRO connected directly to a MIDI sound module, and use it to play and control the sound module.
If you’re not connecting the A-PRO to your computer via USB, you’ll need to use a separately available AC adaptor.
You can purchase the appropriate AC adaptor from your dealer.
fig.MIDI-External-e.eps

MIDI IN
MIDI sound module (sold separately)

Indicator
DC IN

921

* To prevent malfunction and/or damage to speakers or
other devices, always turn down the volume, and turn
off the power on all devices before making any
connections.

AC adaptor
(sold separately)

MIDI OUT

1

Use a MIDI cable to connect the A-PRO’s MIDI OUT connector to the MIDI IN connector of your MIDI sound module.

2
3

Connect the AC adaptor to the A-PRO’s DC IN jack.
Set the A-PRO’s [POWER] switch to “DC” to turn on the power.
Also, switch on the power to your MIDI sound module.

4
5

72

* Place the AC adaptor (sold separately) so the side with
the indicator (see illustration) faces upwards and the
side with textual information faces downwards.The
indicator will light when you plug the AC adaptor into
an AC outlet.

Set the A-PRO’s current channel to match the MIDI receive channel of your MIDI sound module.
When you play the keyboard, your MIDI sound module will produce sound.
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About Standard Driver Mode
Use this mode if you want to use the standard driver provided by your operating system.

Installing the Standard Driver
1

Switch off “ADVANCED DRIVER MODE” (p. 65).

2
3

Close all currently running software.

Input/output Device Settings
In order to use the A-PRO with your software, you’ll need to choose the A-PRO as the
MIDI input/output device.
For details on how to make this setting, refer to the documentation of your software.

Turn the A-PRO’s [POWER] switch off, then on again.
The driver will be installed automatically.

Windows 7/Windows Vista users
MIDI output device

A-PRO
MIDIOUT2 (A-PRO)

MIDI input device

A-PRO
MIDIIN2 (A-PRO)
MIDIIN3 (A-PRO)

* The A-PRO’s MIDI input/output device cannot be used by the Media Player included
with Windows 7/Vista.

Windows XP users
MIDI output device

USB audio device
USB audio device [2]

MIDI input device

USB audio device
USB audio device [2]
USB audio device [3]

Mac OS X users
To specify the MIDI input/output settings for Mac OS X, perform the Audio MIDI
settings described in step 13 and following of “Mac OS X Users” (p. 17).
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Troubleshooting
If you experience problems, read this chapter first. It contains information that will help you solve the problem.
* For help with Windows or Mac OS X operation, refer to the documentation for your computer or operating system.

Problems when Installing the Driver
Can’t start up the installer
Is the CD-ROM inserted correctly in your CD-ROM drive?
Make sure that the CD-ROM is correctly inserted in the CD-ROM drive.

Could the CD-ROM itself or the lens of your CD-ROM drive be dirty?
The installer may not operate correctly if the CD-ROM or the lens of your CD-ROM drive
is dirty. Use a commercially available CD cleaner or lens cleaner to clean the disc or lens.

Are you attempting to install from a networked CD-ROM drive?
The driver cannot be installed from a CD-ROM drive on the network.

Are there any devices labeled “Other,” “Unknown,” or “?/!/X” in the
Device Manager?
If driver installation was not completed successfully, the partially installed driver may
remain in an incomplete state.
Reinstall the A-PRO driver as described in “Reinstalling the driver” (p. 80).

Can’t install the driver according to the procedure
Did you log on to Windows with the appropriate user privileges?
You must log onto Windows using one of the following user names.
• A user name belonging to the Administrators group, such as Administrator
• A user name whose account type is Computer Administrator
* For details, ask the system administrator for your computer.

A warning or error appears during the installation
(Windows)
Could you have connected the A-PRO to your computer before installing
the driver?
If you connect the A-PRO to your computer before installing the driver, an error
message may appear when you begin the installation.
Reinstall the A-PRO driver as described in “Reinstalling the driver” (p. 80).
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In some cases, you may be unable to install the driver because of the
“Driver signing option” settings.
Refer to “Driver signing option settings (Windows XP)” (p. 80) and make the
appropriate settings.

Could other software be running, perhaps in the background (such as
anti-virus software)?
The installation may not occur correctly if other software is running.
Be sure to close all other software before you perform the installation.
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Installation is not successfully completed when you
connect the A-PRO
Could the A-PRO’s ADVANCED DRIVER mode switch be OFF?
Refer to “ADVANCED DRIVER MODE” (p. 65) and set the A-PRO’s ADVANCED DRIVER
MODE to ON. Then, install the driver again.

After you connect the A-PRO, it may take several tens of seconds or
several minutes before it is recognized by your computer.
This is not a malfunction.
Please wait until the Found New Hardware Wizard appears.

Is the A-PRO connected?
Make sure that the A-PRO is correctly connected to your computer.

Could your computer be operating on its battery?
Operation may be unstable if your computer is operating on battery power.
Please use your computer with its power supply connected.

Could you be using a bus-powered USB hub (a hub that does not require
a power supply)?
The A-PRO cannot be used with a bus-powered USB hub (a hub that does not need a
separate power supply). Use it with a self-powered USB hub (a hub that has an internal
power supply or AC adaptor).

Could a USB device other than a mouse or keyboard be connected?
Disconnect all USB devices (other than a mouse and keyboard, if used) from your
computer before performing the installation.

Check the power management settings of your computer.
Your computer’s power management settings may be limiting the power that is
supplied to USB.
Take a look at your computer’s power management settings.
➝ “Power management settings” (p. 81)

Does your computer meet the requirements of the USB specification?
Operation may be unstable if your computer does not meet the electrical requirements
of the USB specification.
In this case, you may be able to solve the problem by connecting a self-powered USB
hub (a USB hub that has an internal power supply or an AC adaptor).

“Found New Hardware Wizard” appears even though
you’ve installed the driver (Windows XP)
Could you have connected the A-PRO to a different USB connector than
the one you used when installing the driver?
If your computer or USB hub has two or more USB connectors, connecting the A-PRO
to a different USB connector may cause your computer to ask for the driver file even
though the driver has already been installed.
This behavior does not indicate a malfunction.
Install the driver as described in step 9 of Installing the Driver (p. 15).

A number such as “2-” appears at the beginning of the
device name (Windows)
Could you have connected the A-PRO to a different USB port?
If you connect the A-PRO to a different USB port, some operating systems may
automatically add a number to the beginning of the device name, but this should not
be a problem when using the A-PRO. If you want to return to the device name that does
not have this number, you can either connect the A-PRO to the same USB port as when
you installed it, or install the driver once again.
➝ “Reinstalling the driver” (p. 80)
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Problems with Settings
Can’t select/use the A-PRO within software or in system
settings
Could the A-PRO be in use by other software?
Close all software you currently have running. Next, switch off the A-PRO’s power, then
turn it back on again.
If this does not solve the problem, reinstall the driver.
➝ “Reinstalling the driver” (p. 80)

Could the A-PRO have been connected when the computer started up?
On some computers, the A-PRO may be unusable if it is already connected when the
computer starts up.
Start up your computer, and then connect the A-PRO.

Could you be using the Media Player included with Windows?
Is the driver installed correctly?
Driver installation may have failed. Please reinstall the driver.
➝ “Reinstalling the driver” (p. 80)

Is the A-PRO device name shown?
If the device name is not displayed, it may be that the driver installation failed. Please
reinstall the driver.
➝ “Reinstalling the driver” (p. 80)

Could the computer to which the A-PRO is connected have entered
standby (suspend) mode, hibernate mode, or sleep mode?
Close all software that’s using the A-PRO. Next, switch off the A-PRO’s power, then turn
it back on again.
If this does not solve the problem, restart your computer.

Could you have disconnected and reconnected the USB cable while
using the A-PRO?
Close all software that’s using the A-PRO. Next, switch off the A-PRO’s power, then turn
it back on again.
If this does not solve the problem, restart your computer.
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The A-PRO’s MIDI device cannot be selected for Media Player on Windows 7 or
Windows Vista.

Have you made “Audio MIDI Settings”? (Mac OS X)
Make the appropriate Audio MIDI Settings as described in “Mac OS X Users” (p. 17).
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Problems when Playing
Playback contains clicks, dropouts, or other problems
Check the power management settings
You may be able to eliminate clicks and pops by changing your system’s power
management settings.
➝ “Power management settings” (p. 81)

Try updating the driver of your display adaptor (Windows)
You may be able to eliminate clicks and pops by updating the driver for the display
adaptor installed in your computer.

In the driver settings dialog box, try selecting the “Light Load” check
box
To change or check this setting, proceed as directed in “Changing or verifying the
driver settings (Windows)” (p. 80).
Changes to this setting will take effect after you turn the A-PRO’s power off, then on
again. Unless you are experiencing problems, you should leave this check box cleared
(the default state).

Try disabling the LAN
Have you set the system’s “Performance” setting? (Windows)
You may be able to solve the problem by changing the “Performance” setting of the
system.
➝ “System “Performance” settings (Windows)” (p. 82)

Could other software programs be running?
Close software that you’re not using.
If the window of a Windows program has been closed but it is still shown in the taskbar,
that program is still running. Close all unneeded software that’s shown in the taskbar.

Have you tried Windows Update or Microsoft Update? (Windows)
Try using Windows Update or Microsoft Update (provided by the Microsoft
Corporation) to update your system to the latest version.

In your computer’s Device Manager, try disabling LAN (wired/wireless).
If this eliminates the clicks and pops, it may be that updating your LAN driver or BIOS
may solve the problem. Check whether updated software is available.

Could you have connected the A-PRO to a USB hub?
Try connecting the A-PRO directly to a USB connector on your computer.

Are you using the included USB cable?
You must use the included USB cable when using the A-PRO. Some commercially
available USB cables do not meet the requirements of the USB standard, and this may
prevent the A-PRO from operating correctly.

Could you have updated the Mac OS X software while A-PRO was
connected?
It has been found that clicks or pops can occur if you performed a Mac OS X software
update while the A-PRO was connected. If so, install the driver once again.
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Can’t play
Was the driver installed correctly?
Driver installation may have failed. Reinstall the driver.
➝ “Reinstalling the driver” (p. 80)

Did you make input/output device settings for your software?
Refer to the owner’s manual of your software and to the following pages, and select the
A-PRO as the input/output device.
• Windows : ➝ “Checking with a SONAR Soft Synths (Windows)” (p. 19)
• Mac OSX: ➝ “Checking in GarageBand (Mac OS X)” (p. 20)

Could the A-PRO be in use by other software?
Close all software you currently have running. Next, switch off the A-PRO’s power, then
turn it back on again.
If this does not solve the problem, reinstall the driver.
➝ “Reinstalling the driver” (p. 80)

Could the computer to which the A-PRO is connected have entered
standby (suspend) mode, hibernate mode, or sleep mode?
Close all software that’s using the A-PRO. Next, switch off the A-PRO’s power, then turn
it back on again.
If this does not solve the problem, restart your computer.

Could you have disconnected and reconnected the USB cable while
using the A-PRO?
Close all software that’s using the A-PRO. Next, switch off the A-PRO’s power, then turn
it back on again.
If this does not solve the problem, restart your computer.

Could the A-PRO have been connected when the computer started up?
On some computers, the A-PRO may be unusable if it is already connected when the
computer starts up.
Start up your computer, and then connect the A-PRO.
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There is a time lag between playing the keyboard and
hearing the software synthesizer
A software synthesizer produces its sounds via the sound card of your computer. There
will be a time lag (“latency”) before the sound of the software synthesizer can be heard
as actual sound from the sound card.
Regardless of the combination of software synthesizer and sound card, there will
always be some latency, but by using the appropriate combination of software and
sound card together with the correct settings, it is often possible to shorten latency to
the point that it causes no problems in practice.
In general, the following settings will be effective in shortening the latency.
• Decrease the audio buffer size of your software
• Decrease the buffer size of your sound card
For details on these settings, refer to the owner’s manual for your software and sound
card.

When using the A-PRO with DAW software, you’re unable
to send system exclusive messages to an external sound
module
You’ll need to make settings in your DAW software to enable the function that passes
system exclusive messages through to your sound module. For details on how to
enable this, refer to the owner’s manual for your software.

Bender lever does not apply pitch bend or modulation
The A-PRO lets you assign MIDI messages to the bender and modulation controllers of
the bender lever. If such assignments have been made, the lever won’t produce pitch
bend or modulation.
Set the bender and modulation to NO ASSIGN as described in “Clearing an Assignment
(NO ASSIGN)” (p. 56).

Aftertouch not applied
The A-PRO lets you assign a MIDI message to the aftertouch controller. If such an
assignment has been made, aftertouch will not be applied.
Set aftertouch to No Assign as described in “Clearing an Assignment (NO ASSIGN)” (p. 56).
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Other Problems
Removing the driver
Your computer may fail to correctly recognize the A-PRO if the driver could not be installed
according to the specified procedure. If so, you’ll need to delete the driver that was
detected by mistake. Use the following procedure to remove the driver, and then install
the driver once again according to the procedure given in “Installing the Driver” (p. 12).

6

Mac OS X users

Windows users

The displayed content may differ depending on your system.

The displayed content may differ depending on your system.

1

2

Insert the included A-PRO CD-ROM into your computer’s CD-ROM
drive.

3

On the CD-ROM, navigate to the following folder and double-click
[Uninstal].
OS

5

1

2

Insert the included A-PRO CD-ROM into the CD-ROM drive of your
computer.

3

Double-click one of the following icons on the CD-ROM to start up
the uninstaller.
OS

Installer

Windows 7

Open the folders [Driver] and then [Win7]

Windows Vista

Open the folders [Driver] and then [Vista]

Windows 7 64-bit edition

Open the folders [x64Driver] and then [Win7]

Windows Vista 64-bit edition

Open the folders [x64Driver] and then [Vista]

Windows XP

Open the folders [Driver] and then [XP]

If you’re using Windows 7 or Windows Vista, a user account control
dialog box will appear. Click [Yes] for Windows 7, or click [Continue]
for Windows Vista.
The screen will indicate “The installed A-PRO Driver will be
uninstalled.” Click [OK].

Start up your computer with all USB cables disconnected.
Make sure that all USB cables other than those for a USB keyboard and USB mouse
are disconnected.

Start up Windows with the A-PRO disconnected.
Make sure that all USB cables other than those for a USB keyboard and USB mouse
(if used) are disconnected.
Log on using a user name whose account type is computer administrator (such as
Administrator).

4

The screen will indicate “Uninstallation was completed.” Click [OK]
to restart Windows.

4

Installer

Mac OS X 10.6 or later

[APRO_Uninstaller] (/Driver/10.6)

Mac OS X 10.5 or earlier

[APRO_Uninstaller] (/Driver/10.4_10.5)

The screen will indicate “This uninstalls A-PRO driver from this
Macintosh.” Click [Uninstall].
If any other message appears, proceed as directed by the message.

5

The screen will indicate “Are you sure to uninstall the driver?”
Click [OK].

6

An Authenticate dialog box or the dialog that asks to type your
password will appear. Enter the password and click [OK].

7

The screen will indicate “Uninstallation is completed.” Click
[Restart] to restart your computer.
It may take some time for the computer to restart.

If any other message appears, proceed as directed by the message.
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Reinstalling the driver

Driver signing option settings (Windows XP)
Driver installation may not be possible due to your settings for “Driver Signing
Options.” Refer to the following, and make the appropriate settings.

If a problem occurred while installing the driver, use the following procedure to
reinstall it.

1

Uninstall the A-PRO driver as described in “Removing the driver” (p.
79).

2

Install the driver once again as described in “Installing the Driver”
(p. 12).

1

Open the “Control Panel,” click [Performance and Maintenance],
and then click the [System] icon.
If you’re using the Classic view, double-click [System].

2

Click the [Hardware] tab, and then click [Driver Signing].
The “Driver Signing Options” dialog box will appear.

Changing or verifying the driver settings (Windows)
The A-PRO’s dedicated driver allows you to check or verify the settings.
The standard MIDI driver provided by the operating system (p. 73) does not allow you
to change the settings.

1

Open the “Control Panel,” and then double-click the [A-PRO] icon.
If you’re using Windows 7, switch “View by:” to the icon display ([Large icons] or
[Small icons]).
If you’re using Windows Vista/XP, and you don’t see the [A-PRO] icon, switch to
[Classic view].

2

The “A-PRO Driver Settings” dialog box will appear. To modify the
settings, make the changes and click [OK]. To simply check the
settings, be sure to click [Cancel] after viewing the settings.

About the items in the Settings dialog box
The [Light Load] check box
Normally, you should leave this check box cleared.
If you change this setting, it will take effect after you’ve turned the A-PRO’s power off,
then on again.
[Show README] button
This displays the online manual for the driver.
Information
This displays the version of the currently installed driver.
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3

In the “Driver Signing Options” dialog box, choose [Warn] or
[Ignore], and click [OK].

4
5

Click [OK] to close the “System Properties” dialog box.
Install the driver as described in the procedure for “Windows XP
Users” (p. 15).
Once you’ve finished installing the driver, change the driver signing options back
to their original settings.
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Power management settings
If you experience problems such as interrupted notes or dropouts in the sound, you
may be able to solve the problem by changing your computer’s power management
settings.

Windows 7 users
1

Open the “Control Panel,” click [System and Security], and then click
[Power Options].
If you’re using an icon display, double-click the [Power Options] icon.

2

6

Click [Setting (Minutes)], and click the down arrow to change the
setting to [Never].

7
8

Click [OK] to close the “Power Options” window.

Windows XP users
1

In “Select a power plan,” choose [High performance].
In the “High performance” area, click [Change plan settings].

6

Click [Setting (Minutes)], and click the down arrow to change the
setting to [Never].

7
8

Click [OK] to close the “Power Options” window.

Click [Change advanced power settings].
In “Power Options” [Advanced Settings], click the [+] symbol for
“Hard Disk,” and click the [+] symbol for “Turn off hard disk after” to
open it.

Close the “Edit Plan Settings” screen.

Open the “Control Panel,” click [Performance and Maintenance],
and click [Power Options].
If you’re using the Classic view, double-click the [Power Options] icon.

If you don’t see [High performance], click [Show additional plans].

3
4
5

Close the “Edit Plan Settings” screen.

2

Click the [Power Schemes] tab, and in the “Power Schemes” field,
select [Always On].

3

Click [OK] to close “Power Options Properties.”

Mac OS X users
1

In “System Preferences,” click [Energy Saver].

2
3

Click [Options].
In the “Processor Performance” field, choose [Highest].
* On some Mac OS X it may not be possible to set the “Processor Performance.”

Windows Vista users
1

Open the “Control Panel,” click [System and Maintenance], and then
click [Power Options].
If you’re using the Classic view, double-click the [Power Options] icon.

2
3
4
5

In “Select a power plan,” choose [High performance].
In the “High performance” area, click [Change plan settings].
Click [Change advanced power settings].
In “Power Options” [Advanced Settings], click the [+] symbol for
“Hard Disk,” and click the [+] symbol for “Turn off hard disk after” to
open it.
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System “Performance” settings (Windows)
You may be able to solve the problem by changing the “Performance” setting of the
system as described below.

Windows XP users
1

Windows 7 users
1

Open the “Control Panel,” click [System and Security], and click
[System].
If you’re using an icon display, double-click the [System] icon.

2
3

At the left, click [Advanced system settings].
A User Account Control dialog box will appear; click [Yes].
If you’re asked to enter an administrator password, log on to Windows as a user
whose account type is administrator, and make the setting again.

4
5
6

Click “Performance” [Settings], and click the [Advanced] tab.
Choose [Background services] and click [OK].
Click [OK] to close “System Properties.”

Windows Vista users
1

Open the “Control Panel,” click [System and Maintenance], and click
[System].

2

In the list of “tasks” shown at the left, click [Advanced System
Settings].

3

A User Account Control dialog box will appear; click [Continue].

If you’re using the Classic view, double-click the [System] icon.

If you’re asked to enter an administrator password, log on to Windows as a user
whose account type is administrator, and make the setting again.

4
5
6
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Click “Performance” [Settings], and click the [Advanced] tab.
Choose [Background services] and click [OK].
Click [OK] to close System Properties.

Open the “Control Panel,” click [Performance and Maintenance],
and double-click [System].
* If you’re using the Classic view, double-click the [System] icon.

2
3
4
5

Click the [Advanced] tab, and click “Performance” [Settings].
Click the [Advanced] tab.
Choose [Background services], and click [OK].
Click [OK] to close “System Properties.”
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MIDI Implementation Chart
Model: A-300PRO/500PRO/800PRO

Date : Jan. 16, 2010 Version : 1.00
Transmitted

Function...

Recognized

Basic
Channel

Default
Changed

1
1–16

X
X

Mode

Default
Messages
Altered

Mode 3
OMNI ON/OFF, MONO, POLY
**************

X
X
X

: True Voice

0–127
**************

X
X

Velocity

Note ON
Note OFF

O (9n v=1–127)
O (8n v=1–127), (9n v=0)

X
X

Aftertouch

Key’s
Ch’s

O
O

X
X

Pitch Bend

O

X

Control Change

O

X

O (0–127)
**************

X
X

O

O

Note
Number

Program
Change

: True #

System Exclusive
System
Common

: Song Pos
: Song Sel
: Tune

O
O (0–127)
O

X
X
X

System
Real Time

: Clock
: Command

O
O

X
X

Aux Message

: All Sound Off
: Reset All Controller
: Local control
: All Notes Off
: Active Sense
: Reset

O *1 (120)
O *1 (121)
O
O *1 (123)
O
O

X
X
X
X
X
X

Notes

Remarks

*1 Transmits When the Panic function is executed.
Mode 1 : OMNI ON, POLY
Mode 3 : OMNI OFF, POLY

Mode 2 : OMNI ON, MONO
Mode 4 : OMNI OFF, MONO

O : Yes
X : No
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Main Specifications
A-300PRO/500PRO/800PRO: MIDI KEYBOARD CONTROLLER
● Keyboard
A-300PRO: 32 keys (with velocity and channel aftertouch)
A-500PRO: 49 keys (with velocity and channel aftertouch)
A-800PRO: 61 keys (with velocity and channel aftertouch)

● Controllers
Pads: [A1]–[A8]
Buttons: [B1]–[B4], [L1]–[L9]
Knobs: [R1]–[R9]
Sliders: [S1]–[S9]
Foot Pedals: HOLD (P1), EXPRESSION (P2)
Bender Lever: BENDER, MODULATION
Keyboard Aftertouch: AFTERTOUCH
[VALUE] knob

● Buttons
[ACT] button, [
] button, [
] button, [DUAL] button, [SPLIT] button,
[UPPER] button, [LOWER] button, [SHIFT] button, [TRANSPOSE] button,
OCTAVE [–] [+] button

● Display
16 characters, 2 lines LCD (with Backlight)

● Side Panel
[POWER] Switch (USB/OFF/DC IN)
[MIDI MERGE] Switch (ON/OFF)

● Connectors
HOLD (P1) Pedal Jack: 1/4 inch phone type
EXPRESSION (P2) Pedal Jack: 1/4 inch TRS phone type
MIDI Connectors (IN, OUT)
USB Connector
DC IN Jack

● Power Supply
DC 9 V (AC Adaptor) or USB Bus Power

● Current Draw
300 mA (AC Adaptor)
300 mA (USB Bus Power)

● Dimensions
A-300PRO: 605.9 (W) x 250.8 (D) x 91.4 (H) mm
23-7/8 (W) x 9-7/8 (D) x 3-5/8 (H) inches
A-500PRO: 838.9 (W) x 250.8 (D) x 91.4 (H) mm
33-1/16 (W) x 9-7/8 (D) x 3-5/8 (H) inches
A-800PRO: 1001.9 (W) x 250.8 (D) x 91.4 (H) mm
39-1/2 (W) x 9-7/8 (D) x 3-5/8 (H) inches

● Weight
A-300PRO: 2.9 kg / 6 lbs 7 oz
A-500PRO: 3.8 kg / 8 lbs 7 oz
A-800PRO: 4.5 kg / 9 lbs 15 oz

● Accessories
A-PRO CD-ROM
Cakewalk Production Plus Pack DVD-ROM
USB Cable
Owner’s Manual
Cakewalk Production Plus Pack installation guide
License agreement

● Options
Pedal Switch: DP-2/DP-10
Expression Pedal: EV-5/EV-7
AC Adaptor (Please contact the retailer from whom you purchased the product, or the
nearest Roland Service Center.)
* In the interest of product improvement, the specifications, appearance, and/or
contents of this unit are subject to change without prior notice.
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Index
A
AC Adaptor ................................................................... 72
ACT ................................................................................... 21
[ACT] Button ................................................................... 8
ADVANCED DRIVER MODE ...................................... 65
ADVANCED DRIVER SWITCH ................................... 57
AFT Mode ...................................................................... 25
Aftertouch ..................................................................... 25
Aftertouch Assignment ............................................ 50
Aftertouch Mode ........................................................ 25
A-PRO .............................................................................. 23
A-PRO 1 ............................................................ 25, 61, 64
A-PRO 2 ............................................................ 25, 61, 64
A-PRO Editor ................................................................. 22
Assign Message .................................................... 24, 29

B
BANK ........................................................................ 43, 68
Bank Select ............................................................. 35, 68
Bend Range ................................................................... 41
Bender Lever ........................................................... 9, 41
bus power ..................................................................... 11
Button Mode ......................................................... 25, 55

C
Cakewalk Production Plus Pack ............................... 2
CC#00 .............................................................................. 68
CC#32 .............................................................................. 68
Center Click ................................................................... 55
Channel Message .................... 24, 33, 34, 35, 36, 37
Channel Pressure ................................................. 25, 33
Checksum ...................................................................... 38
Clearing an Assignment ........................................... 56

Clock ................................................................................ 64
Control Change ........................................................... 34
Control Change Assignment .................................. 51
Control Map ........................................................... 22, 27
Controllers .............................................................. 10, 24
Copied ............................................................................ 56
Copy ................................................................................ 27
Copying an Assignment ........................................... 56
Current Channel .......................................................... 42

H

D

INCREASE ....................................................................... 55
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Install the Driver
Mac OS X ................................................................. 17
Windows 7 .............................................................. 12
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Windows XP ........................................................... 15

DC ..................................................................................... 11
DC IN Jack ............................................................... 11, 72
Display .............................................................................. 8
Driver Signing Options Settings ............................ 80
DUAL ............................................................................... 45
[DUAL] Button ................................................................ 9
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Edit Menu ...................................................................... 27
EDIT Mode ..................................................................... 48
Edit Mode ...................................................................... 41
Encoder Simulate ....................................................... 37
[ENTER] Button .............................................................. 8
Export Assign List ....................................................... 27
EXPRESSION .................................................................. 11
EXPRESSION (P2) Jack ............................................... 11
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H-ACTIVITY .................................................................... 69
H-ACTIVITY ON/OFF ................................................... 58
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[HOLD] Button ............................................................. 10
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KEYBOARD AFTERTOUCH CURVE .................. 57, 61
KEYBOARD PORT SET ......................................... 57, 61
Keyboard Set Window .............................................. 26
Keyboard Sets .............................................................. 40
Keyboard Shortcuts ................................................... 28
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Knob .................................................................................. 8
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For the U.K.
THIS APPARATUS MUST BE EARTHED
THE WIRES IN THIS MAINS LEAD ARE COLOURED IN ACCORDANCE WITH THE FOLLOWING CODE.
GREEN-AND-YELLOW: EARTH, BLUE: NEUTRAL, BROWN: LIVE
As the colours of the wires in the mains lead of this apparatus may not correspond with the coloured markings identifying the
terminals in your plug, proceed as follows:
The wire which is coloured GREEN-AND-YELLOW must be connected to the terminal in the plug which is marked by the letter E or
by the safety earth symbol or coloured GREEN or GREEN-AND-YELLOW.
The wire which is coloured BLUE must be connected to the terminal which is marked with the letter N or coloured BLACK.
The wire which is coloured BROWN must be connected to the terminal which is marked with the letter L or coloured RED.
WARNING:
IMPORTANT:

For the USA

DECLARATION OF CONFORMITY
Compliance Information Statement
Model Name :
Type of Equipment :
Responsible Party :
Address :
Telephone :

A-300PRO/A-500PRO/A-800PRO
MIDI Keyboard Controller
Cakewalk, Inc.
268 Summer Street Boston, MA 02210
(617) 423-9004

For C.A. US (Proposition 65)

WARNING
This product contains chemicals known to cause cancer, birth defects and other reproductive harm, including lead.
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For EU Countries
This product complies with the requirements of EMC Directive 2004/108/EC.

For the USA

FEDERAL COMMUNICATIONS COMMISSION
RADIO FREQUENCY INTERFERENCE STATEMENT
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
– Reorient or relocate the receiving antenna.
– Increase the separation between the equipment and receiver.
– Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
– Consult the dealer or an experienced radio/TV technician for help.
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and
(2) this device must accept any interference received, including interference that may cause undesired operation.
Unauthorized changes or modification to this system can void the users authority to operate this equipment.
This equipment requires shielded interface cables in order to meet FCC class B Limit.
For Canada

NOTICE
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

AVIS
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.
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Contents of the Package
For China
The package of the A-300PRO/500PRO/800PRO (which we’ll subsequently refer to as the A-PRO) contains the following items. When you open the package, first make sure that all items are
included. If any are missing, contact the dealer where you purchased the A-PRO.

MIDI keyboard controller A-PRO

USB cable
Use this cable to connect the A-PRO to the USB connector of your computer. For details
on connections, refer to “Installing the Driver” (p. 12).

fig

* Please use only the included USB cable. If you require a replacement for the supplied
USB cable (for example due to damage or loss), please contact the nearest Roland
Service Center, or an authorized Roland distributor, as listed on the separate sheet
titled “Information.”

Owner’s manual
This is the document you’re reading. Keep it at hand for reference when needed.
* The photo show the A-500PRO.

Cakewalk Production Plus Pack installation guide
CD-ROM, DVD-ROM (one each)

This explains the installation and user registration process for the software included on
the Cakewalk Production Plus Pack DVD-ROM. Unless you complete the user
registration and obtain a registration code as directed in this guide, you won’t be able
to use the software for more than thirty days after installation.

A-PRO CD-ROM
This contains the A-PRO drivers.
Cakewalk Production Plus Pack DVD-ROM
Cakewalk Production Plus Pack, packed with a lavish array of high-quality music
production tools, is included.
* Avoid touching or scratching the shiny underside (encoded surface) of the disc.
Damaged or dirty discs may not be read properly. Keep your discs clean using a
commercially available CD cleaner.
202

Do not attempt to play back a CD-ROM or DVD-ROM in a conventional
audio CD player. The resulting sound may be of a level that could cause
permanent hearing loss. Damage to speakers or other system components
may result.

2

Copyright © 2010 ROLAND CORPORATION
All rights reserved. No part of this publication may be reproduced in any form
without the written permission of ROLAND CORPORATION.
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Before using this unit, carefully read the sections entitled: “USING THE UNIT
SAFELY” and “IMPORTANT NOTES” (p. 3; p. 5). These sections provide important
information concerning the proper operation of the unit. Additionally, in order to
feel assured that you have gained a good grasp of every feature provided by your
new unit, Owner’s manual should be read in its entirety. The manual should be
saved and kept on hand as a convenient reference.
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